
User’s Manual
T-Jet2™

SDT-1200w

Version 1.7



     Equipment Zone
17-20 Willow Street
Fair Lawn,NJ 07410 USA
Office +1 201-797-1504
Fax +1 201-797-1505
Toll Free +1 800-408-0040
Technical Support       http://support.equipmentzone.com
Email: support@equipmentzone.com
www.equipmentzone.com
Printed in the U.S.A.



3

Table of Contents
Safety Instructions……………………………………………………………………...6
Chapter One: Introduction to T-Jet2…………………………………………………. 9

About the T-Jet2……………………………………………………………………...9
T-Jet2 Important Points…………………………………………………………….. 10
About the Garment Decorating Business………………………………………….12
A Word of Advice……………………………………………………………………..14

Chapter Two: Unpacking and Setup.………………………………………………… 15
Unpacking Your T-Jet2………………………………………………………………16
Installing the Bulk Ink System…………………………………………………….....21

Chapter Three: Software Installation and Setup.…………………………………. 29
Software Overview……………………………………………………………………29
Installing Epson Drivers……………………………………………………………...30
Installing FastRIP and FastARTIST………………………………………………...32

Chapter Four: Computer Graphic Software.………………………………………... 35
Computer Graphics Overview.………………………………………………………35
FastARTIST/Photoshop - Editing Bitmap/Pixel Based Artwork………………….37
Removing Backgrounds with Photoshop…………………………………………..45
Preparing Images with Gradient Backgrounds…………………………………….46
Fixing Bad Line-Art in Photoshop and FastARTIST………………………………52

Chapter Five: Printing with the T-Jet2.………..……………………………………...55
Control Panel Buttons and Lights.…………………………………………………..55
Basic Steps for Printing a White Shirt………………………………………………57
Print Modes and FastRIP…………………………………………………………….62
How to use the Print Pass Counter…………………………………………………69
Canceling a Print Job………………………………………………………………...70
Printing From Various Graphic Programs.…………………………………………72
Production Rates and Ink Costs.……………………………………………………78

Chapter Six: Printing White Ink.……………………………………………………… 75
White Ink Overview.…………………………………………………………………..75
Applying Pretreatment.……………………………………………………………….77
Printing White Ink….………………………………………………………………….78
White Ink Troubleshooting…………………………………………………………...85

Chapter Seven: Printing Other Items..…………………………….………………… 87
Printing on General Items..…………………………………………………………..87
Printing on Baseball Caps.…………………………………………………………..90
Non-Textile Printing…………………………………………………………………..91
Printing Golf Balls…………………………………………………………………….100

Chapter Eight: Simple Maintenance and Utilities..……………………………….. 107
Running Head Cleaning Utilities..…………………………………………………..107
Aligning the Print Head……………………………………………………………… 109
Emptying the External Waste Bottle.……………………………………………….111
Resetting Ink Counter………………………………………………………………..112



4

Print Head Replacement……………………………………………………………..112
Chapter Nine: Preventative Maintenance and Problem Solving………………...113
Keep your Encoder Strip Clean……………………………………………………..113
Removing the Capping Station……………………………………………………...117
Humidity and Environmental Control……………………………………………….124
Preparing your T-Jet for Down Time………………………………………………..125
Eliminating Ink Drops on Shirts……………………………………………………..128
Clean/Adjust Drive Roller and Belt………………………………………………….130
Five Minute Daily Maintenance……………………………………………………..133
Weekly or Monthly Maintenance…………………………………………………… 134
Daily/Weekly Maintenance Schedule Check Lists………………………………..135

Chapter Ten: Troubleshooting………………………………………………………...137
Print Head Hitting the Print Bed……………………………………………………..153

Chapter Eleven: Transporting Printer………………………………………………..155
Chapter Twelve: Product Support………………………………………………….....161
Appendix A–Printing with Seven Color Standard T-Jet………………………......165
Creating Special Print Modes……………………………………………………….167

Requirements and Notices…………………………………………………………….177
T-Jet2 SDT-1200w Specifications……………………………………………………..178
FCC Compliance Notice………………………………………………………………... 179
Declaration of Conformity…………………………………………………………….. 180



6

Read the Safety Instructions
Before you start printing read the safety instructions

 Make sure to follow all the warnings on the printer.
 Use the type of power source that is indicated on the printer’s label.
 Connect all equipment to grounded outlets. Do not use the same outlet for

any other system such as a copy machine or an air control unit that turns on
and off.

 Put the printer where the power outlet is easily seen.
 Do not let the power cord be damaged.
 If you are using an extension cord make sure the power ampere rate does not

exceed the cords ampere rate of the printer.
 Keep electromagnetic devices and other potential sources with magnetic

fields away from your printer.
 Keep away from locations that have high humidity, shocks, vibrations, debris

or dust.
 Leave enough space around the printer for proper ventilation.
 Do not leave the printer near heat sources such as radiators, heat vent, or

direct sunlight.
 Place the printer on a flat table or on a stable surface that extends around the

printer. The printer will not work properly if it is tilted or leaning.
 When packing and moving the printer do not set the printer on its side or

upside down this may cause the ink to spill.
 Turn off the printer before cleaning. Clean with a damp cloth. Do not spill any

liquid on the printer.

Caution:
 Do not unplug the printer to shut it off. Use the power button instead.
 Do not unplug the printer until the green power light is off.
 Do not block any of the printer’s vents or insert anything foreign in its slots.
 Unless explained by this manual, don’t try and service the printer yourself.
 Turn off the printer, unplug and take it to a qualified service personnel.
 Keep the machine level.
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Safety Instructions for Ink Cartridges
 Always keep ink cartridges out of the reach of children.
 While handling ink be careful not to spill it on your skin. If ink does get on your

skin wash it thoroughly with soap and water. If it gets on your eyes flush them
out immediately with water.

 Do not put your hand in the printer or touch the cartridges once printing.
 Do not move the printer head by hand; doing so may damage the printer.
 Store the ink cartridges in a cool dark place.
 If you store the cartridge in a cold environment and are ready to use them set

them on a table at room temperature before you use them.
 Do not dismantle the ink cartridge. This could damage the print head.
 Do not touch the IC chip on the ink cartridges. This will effect the normal

printing operations.
 If you remove the ink cartridges make sure to place them in a bag individually

to keep them away from dust, dirt, and debris.
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Chapter 1

Introduction to the T-Jet2 and the
Garment Decorating Industry

About the T-Jet2
The T-Jet2 is an inkjet printer that has been
made to print on almost any type of garment,
fabric material, and even non-textiles such as
golf balls, keyboards, tennis balls, etc. (Currently
nylon and certain synthetic materials are non
printable items). In the past this was difficult if not
impossible because there was not an ink that
would work on 100% cotton and 50/50 cotton/
polyester blends that would stand up to washing.
That has all changed with FastINK Textile Ink designed specifically for cotton and
cotton blend materials as well as a multitude of other materials and non-textile items.
FastINK Textile Ink is also used when printing on Non-Textiles by simply applying
FastT-Jet Non-Textile Series Pre/Post Treatment to the item allowing the ink to
adhere to the surface.

T-Jet2 prints on 100% cotton the best. It will print on 50% cotton/50% polyester
blends, 100% polyester and many other natural and synthetic materials but you will
not have the print brightness. And, when printing on any dark garment with polyester
fibers you can get dye bleeding into your ink. A white print on a 50/50 red garment
may turn pink when you heat the garment to set the ink.

Since T-Jet2 is based on standard inkjet technology (the Epson 2200 printer is the
heart of the system). You can print from any graphic application such as Adobe
Illustrator, Adobe Photoshop, Adobe InDesign, CorelDRAW, Macromedia Freehand,
QuarkXPress, and FastARTIST (included with your T-Jet2).

The T-Jet2 prints on items in one to two minutes for a standard T-Shirt size image.
Besides T-Shirts and non-textiles items, the T-Jet2 can print on mouse pads,
thongs, ladies tops, towels, tote bags, bibs, caps, leather and more. Use your
imagination the possibilities are endless.

Note: The T-Jet2 works ONLY on a Windows system.

Your new T-Jet2 includes the latest versions of both FastARTIST and FastRIP.
FastARTIST is a Windows only graphic application that will help make preparing an
image for print a mere click or two of the mouse. With One click wonder underbasing
and simple clipping features, FastARTIST can help ease the transition if you are not
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familiar with other graphic applications. For avid
users of Photoshop, CorelDraw, Illustrator, etc.,
you may choose to work within your graphic
application of choice and still setup the image
properly for printing. There is also the option of
importing an image into FastARTIST from other
graphic applications in order to take advantage of
the one click Underbase Wizard. Either way, all
images must print to FastRIP for final output.

FastRIP works as the T-Jet2’s print queue and 
print manager, allowing you to not only select
different print modes and other print attributes,
but archive print jobs for future reprints. You must
use FastRIP when printing a white underbase.

Macintosh Users–Images may be created
using your Mac then transferred to a PC for printing.

If you have a Standard Red T-Jet that uses seven colors of ink (no white) you can
print from a Windows or Macintosh based computer. See Appendix A.

Two Models
There are two basic models of the T-Jet: SDT-1000 and SDT-1200. The Standard
T-Jet SDT-1000 (discontinued) has a red case and prints on light colored shirts
only without the White Ink Option kit. The T-Jet2 SDT-1200 has a chrome cover,
slightly larger bed and includes the White Ink Option. This manual covers the T-Jet2,
but many items covered here apply to the SDT-1000 red machine as well.
For more specific details about the T-Jet Standard (red machine) refer to
Appendix A.

T-Jet2 Important Points
Maintenance

Although the T-Jet2 is “simply” an inkjet printer, the number one problem we 
encounter when providing support is the lack of maintenance to the machine.
Printing on T-shirts is not the same as printing on paper using the inkjet printer
behind your desk. A shirt gives off more lint and the amount of ink deposited is much
greater than for paper. Plus, when printing on dark shirts you need to spray a
pretreatment on the shirt. This pretreatment can get inside the printer and cause
problems so we recommend you pretreat shirts as far away as possible or in another
room. If you take ownership of the required maintenance, printing with the T-Jet2 will
be a joy. If you decide that a few minutes each day is too much time to spend
to maintain your investment then you will have more ruined shirts and some
frustration. See chapters 8 and 9 for more details.
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Poor Artwork
With graphic programs readily available, everyone is an artist. Poor quality artwork
will be one of your biggest concerns. There is no magic that will make a low
resolution, low quality piece of artwork look great on a shirt. It is important that you
take time to learn as much as you can about graphic art programs and some of the
simple methods used to improve the quality of customer supplied artwork.

Support

Technical Support +http://support.equipmentzone.com
Corp. Office +1 201-797-1504
Fax +1 201-797-1505
Email: support@equipmentzone.com

Support hours: 9:00am to 8:00pm EST Monday through Friday

There are dozens of videos online showing how to use and maintain your T-Jet2.

For best results read this entire manual first before using the T-Jet2.
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A Word of Advice
When starting a business it is often easy to think nothing will go wrong. You need to
be positive about your venture but in the beginning, expect the worse. If you take
orders for printed shirts before you even received your machine, you might find that
deadlines are hard to meet because of the learning curve and unexpected problems.
The garment business is one of deadlines, event shirts, shirts for special occasions
and shirts with “dates” on them. You must always give yourself room for error. Shirt
suppliers might not ship on time. You might not have checked your ink inventory and
run out of a color. Yes, you will ruin a few shirts and you need to accept this as a fact
of life in the garment decorating industry. To have the most success, allow extra time
to fill orders and don’t make commitments that might be hard to make.

There is nothing more rewarding than seeing someone wearing one of your
creations but nothing more disturbing than working all night to meet a deadline.
Anyone who has been in this industry has had the joy and sorrow of both. Plan
ahead and always have a cushion to make sure you meet deadlines.
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Chapter 2

Unpacking and Setup

Save the box and all the packing
Please retain all shipping materials, bags, boxes and directions. If you ever
need to return the unit for repair or to transport your T-Jet2 you will need
these items. If you return or ship a T-Jet2 without using the original shipping
carton you may void the warranty.
Please read all of the unpacking and setup directions FIRST before attempting to
setup or use your printer. DO NOT plug your T-Jet2 into AC Power until you are told
to do so in this manual.
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Unpacking Your T-Jet2
If the instructions on the outside of
the box were followed, you have
already checked the outside of the
box for any shipping damage. If you
see obvious damage please contact
the freight carrier immediately so you
can schedule a freight inspection.
Along with this guide, you will find
separate instructions for proper
methods in unpacking as well as a
separate box with accessories for
your T-JET. Remove side protector
panels and accessories.

NOTE: Save all packing materials
and bags as well as the box for
future shipping needs.

Main Box Contents
 Software/Training
 T-Jet2 Manual
 Waste Ink Pads
 Power Cable
 USB Cable
 Height Jig
 Maintenance Kit
 Adjustable Shelf Bracket

Box 2
 FastARTIST Package
 Shirt Boards and Hoop
  EZ Pro Bulk Ink System
 Cleaning System
 Inks
 Pretreatment
 Sprayer
 Parchment Paper

Industrial Bulk Ink System Parts
 7 - Easy-fill bottles. Four 8oz.bottles for CMYK and four bottles for

white ink.
 7–Ink Cartridges
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.
 1–Syringe
 1 - set of cartridge chips
 1 - Latex gloves

Waste Bottle
 Waste Ink Bottle
 Secure Nut and Ink Line Fitting
 Waste Bottle Shelf Bracket

Lift the T-Jet unit from the box
With an assistant, lift the T-JET out of the
box and place it on a firm, level surface.

Lift from CHROME SIDES ONLY

DO NOT lift alone. Lift with your legs, not
your back! Place the printer on a solid table
or work surface that will not shake or
vibrate during printing. The table must be
level! For best results place the unit on a table
with extra room for a computer,
replacement ink and work space.

Preparations
1. Remove Hold Down Clamps

With a Phillips-head screwdriver, loosen the four
bed holder brackets located towards the bottom of
each side of the bed. Push them out of the way of
the bed and tighten. Move the Print Bed back and
forth to ensure smooth movement. Return the Print
Bed back to its' eject position.
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2. Remove all Packing Materials
a) Remove all packaging tape from the printer and Print Head.

b) Remove "Pull" tabs from the Cleaning Cartridges and place them back in
the printer.

3. Check the Print Bed Height
Using the Print Bed Adjustment knob located on
the front of the eject side of the Print Bed, lower
the bed enough so that the Print Head does not
hit anything while traveling back and forth. Turn
counter-clockwise until it is low enough. Make
sure the Print Head does not hit anything before
continuing to the next step.

Open the rest of the boxes that contain a variety of accessories and products.

Location, location, location
The T-Jet2 should not be in
direct sunlight, direct airflow
(may dry out and clog printing
heads), dusty areas, close to a
strong magnetic force, or in
areas of excessively high
humidity (it likes not to be too
dry or too moist with a level of
35% to 80% relative humidity).
Since you will be handling wet
ink to refill the bulk system ink
bottles you should protect any carpet or floor covering with mats.

This is an expensive and delicate inkjet printer
that does NOT like being in a hot or cold shop or
garage without proper air-conditioning controls. If
left unattended for days or weeks in a hot dry
environment you will have clogged print heads. If
you are going to leave your printer for more than
two to three days without use, consult Chapter
Nine (Preventative Maintenance and Problem
Solving) for installing refillable cleaning cartridges
during long down times.
Place the T-Jet2 close to a heat transfer press or small conveyor dryer to cure the
ink. If you have two or three T-Jet2s as a production work station, place them
around or near the heat source.
At night and when the T-Jet2 is not in use, cover the machine to keep it protected.
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Important Point!
When printing white ink you must spray a
pretreatment on the shirts before printing. DO NOT
spray this pretreatment near your T-Jet2. In fact, if
possible, pretreat shirts in a different room or make a
simple cardboard enclosure to use for applying
pretreatment. The pretreatment is sticky and can get
on the “magic” of the printer called the Encoder Strip. 
The Encoder Strip is a thin piece of clear plastic with
data that is read by the print head as the unit
operates. The Encoder Strip tells the head exactly
where to print an image. If the Encoder Strip gets
dirty, the printing head gets confused and will print
multiple images, strips of solid ink, and many other
irregular printing patterns.

Check for Printing Head
movement

There is a READ ME sheet on the
plastic. Please read it now. Remove
the tape holding the top plastic lid
closed. Remove the tape and bracket
holding the inkjet printing head in place.
Follow the directions on the Read Me
about checking to see if the printing
head hits the shirt bed. In order to have
sharp printed images during inkjet printing the head must move very close to the top
of the shirt. During shipping or removing from the shipping box, the bed of the T-Jet2
may have shifted slightly. If the head does NOT hit the side of the printing bed you
can proceed. If the printing head hits the side of the bed when moving it by hand,
refer to Chapter 10–Troubleshooting for details on how to adjust the head height.
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Plug unit into AC power
DO NOT TURN THE PRINTER ON YET! YOU MUST CHECK TO SEE
IF THE PRINT HEAD MOVES FREELY. YOU CAN TURN THE
PRINTER ON AFTER YOU INSTALL THE BULK SYSTEM.
Insert AC cord in unit and plug into a power strip with a
surge protector. Avoid plugging multiple items into the
T-Jet2 power strip. The T-Jet2 has a dual voltage
power converter and will work on 50 or 60 cycle current
that ranges from 110 volts to 220 volt.
For more reliable results plug the unit into a UPS
(Universal Power Supply) to help prevent ruined
shirts during power fluctuations.
Do NOT plug other high power items into the same circuit such as a heat
transfer press. The heat transfer press will cycle on and off causing power
fluctuations, potentially ruining shirts. This is VERY IMPORTANT!
Important Note: NEVER shut off your T-Jet2 at the power strip; use the Power
Switch on the actual unit. During Power Off of any inkjet printer, the printer goes
through a shut down cyclethat seats the head so you won’t get head clogs. If you 
shut the unit off at a power strip it does not go through a normal shut down.

Connecting your T-Jet2 to the computer
You can connect the T-Jet2 to a computer with a
normal parallel cable, USB cable, or even an IEEE
1394 Firewire cable. The machine came with a
special gold tip USB cable; use this cable for best
results.
In any situation take care to not use a cable that is
excessively long and do not use a switch box, which can often cause communication
problems.
Your computer needs to be a PC/Windows computer if
you will be printing with white ink. For best results you
should use a very fast computer with at least 512mb of
Ram. Ram is inexpensive and if you can put 1 GB or
more on your computer it will prevent problems when
printing large files.
The Universal Serial Bus–USB–method of
communication is standard on all newer computers,
but what is not commonly known is that there is only a
certain amount of power supplied to the entire “bus.” 
This means that if you have a number of items
plugged into different USB ports on your computer, it
might cause communication issues with the T-Jet2.
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If possible and for the best performance use a dedicated computer to control
your T-Jet2 and do not plug anything else into extra USB ports when printing
to your printer.

It is very important to note that if you do not follow the recommended
environment, power, maintenance, and operating conditions, you can void the
warranty of your T-Jet. The T-Jet does NOT like to be in a hot, dry shop with
excess dust, as well as being plugged into outlets with a lot of other items.
Please read and understand the operating conditions and maintenance
requirements for your money making investment.
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Chapter 3

Software Installation and Setup
Software overview

About Your Computer
The T-Jet2 is a high performance inkjet printer. Graphic files can be large, and the
data sent from FastRIP to the printer is sent at a very high speed (high data rate). In
order to get the fastest speed and have fewer communication problems with the
printer, you need a fast computer. You can use a standard desktop computer or
even a laptop with the T-Jet2, but for the best performance, the computer should
have at least 512mb of RAM (1 GB to 2 GB of RAM is better).
If you want to continue working and creating artwork while the T-Jet2 is printing,
having a higher amount of RAM on board your computer is essential. Ideally you
should have a computer that is ONLY used to power the T-Jet2.
While sending data to the T-Jet2 with a USB cable (preferred), do not have anything
else plugged into a USB port (other than a mouse). USB ports do not have a lot of
power and the more devices plugged in the more power drain that will occur. In
order to run FastARTIST you MUST have a PC/Windows based machine - MAC
users, create the artwork in your favorite program and simply network or copy the
files over to the PC “workstation.”

Graphic and RIP software
Your new T-Jet2 includes the latest versions of both
FastARTIST and FastRIP. FastARTIST is a Windows only
graphic application that will help make preparing an image
for print a mere click or two of the mouse. With One click
wonder underbasing and simple clipping features,
FastARTIST can help ease the transition if you are not
familiar with graphic applications. For avid users of
Photoshop, CorelDraw, Illustrator, etc., you may choose to
work within your graphic application of choice and still
setup the image properly for printing. There is also the
option of importing an image into FastARTIST from other graphic applications in
order to take advantage of the one click Underbase Wizard. Either way, all images
requiring a white underbase must print to FastRIP for final output. Seven color prints
may print directly to the printer.

Once a graphic file is ready to print, it needs to be sent to special software called a
RIP (Raster Image Processor) that tells the machine what image resolution to use,
how many passes to make of the colors, when and how to print the underbase and
highlight and how much ink to lay down. RIP is the magic of high-end printers in any
graphic application and we have our own very special rip program called FastRIP.
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You can now print directly to FastRIP from any standard graphics program like
Adobe Photoshop, Adobe Illustrator, Corel Draw or Macromedia Freehand and still
take advantage of the white underbase option.

For information about installing and using FastARTIST and FastRIP consult the
individual programs User Manual.
For best results turn OFF all Screen Savers when printing to your T-Jet2.

Installing Epson drivers

Epson drivers
Even though you will be printing to FastRIP, there are many
times you will need to use the standard Epson software to
do nozzle checks, head cleanings and standard inkjet
maintenance. The Driver CD you received with the unit
contains the Windows and Mac drivers for the Epson 2200.
Since drivers change and improve, you can download the
most current driver for the Epson 2200 by simply going to
http://support.Epson.com and follow the links to the Drivers section.

Windows Installation
To install the Epson driver, insert the CD in
your computer. Go to My Computer and select
the CD drive. There will be two Printer Drivers
folders accessible; one is for Windows XP and
2000 (the preferred operating system) and the
other for Windows ME operating system.

For Windows XP, double click on the folder
called Printer Driver v5.5bs, then double click
on the sub-folder called XP 2000. Locate the
Setup folder and double click to open. Double-
click on a file called Setup and follow the on-
screen prompts.
Note: Some newer Windows XP computers
automatically install the Epson printer drivers.

Windows will install the Epson 2200 driver on
your computer and diver functions will be
accessible from the Printers and Faxes folder
located within the Control Panel as well as from
your favorite graphic application.
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If you have any problems installing the driver or getting your program to find the
printer driver, call our support department and we will gladly walk you through the
process.
Toll Free +1 888-MYTJETS (698-5387)
Technical Support +1 480-929-2937
Corp. Office +1 480-929-0640
Fax +1 480-929-0766
Email: support@usscreen.com.
Internet: www.ScreenPrinters.Net Click on Support
Support hours: 7:00am to 8:00pm Monday through Friday

9:00am to 3:00pm Saturday
(Mountain Standard Time) USA

Note: Arizona does not observe “Daylight Savings” in the US.
In the summer months, Arizona is on the same time as California.

Macintosh Installation (for printing 7 color only)
To install the Epson drivers, insert the CD in
your computer. The CD will show up on your
Desktop. Double-click on the CD icon on the
Desktop.
The CD will show you drivers for both Mac OSX
and Mac OS 8.6 - 9.x. Double-click on the
appropriate operating system and then on the
appropriate driver.
Follow the on-screen prompts. Macintosh will
install the Epson 2200 driver on your computer.

Mac OS 8.6 to 9.x: (for printing 7 color only)

Open the Chooser and then select the
following options:

SP 2200
Your USB or FireWire port
Background printing (on or off)
Then close the Chooser.
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Mac OS X 10.2.8 - 10.4.x: (for printing 7 color only)
After doing a normal installation and the
computer restarts, go to Macintosh
HD/Applications/Utilities. Select Print Center
(Jaguar) or Printer Setup Utility (Panther).
If the Stylus Photo 2200 appears in the
Printer List, select it and click Add.

If the Stylus Photo 2200doesn’t appear, 
make sure your printer is turned on and
connected. Restart the computer and try
again.
Select the following options on the next screen:

EPSON USB or EPSON FireWire at the top of the screen

Stylus Photo 2200 below

Open Page Setup menu at the bottom of the screen and select the Standard. Then
click Add. When printing with T-Jet2 you will be accessing this driver from within
your favorite graphic application.
If you have any problems installing the driver or getting your program to find
the printer driver, call our support department and we will gladly walk you
through the process.

Installing FastRIP and FastARTIST
The magic that makes the T-Jet2 so
powerful is not only the printer and ink, but
the software that drives it. As mentioned
earlier, the T-Jet2 comes with two very
powerful programs–FastARTIST and
FastRIP. FastARTIST is a complete
graphic program much like Corel Draw
and Adobe Photoshop. You can use
FastARTIST for all of your graphic image
creation or you can simply create images
in Corel Draw or Adobe Photoshop and
import them into FastARTIST to take advantage of one click Underbase Wizard or
simple clipping options.

Note:For details on installing FastARTIST, consult the FastARTIST User’s Manual.
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FastRIP
FastRIP is a printer driver that is specially
designed to power your T-Jet2. A RIP
converts the data from a graphics program
to computer code called Postscript. This is
a powerful language that allows much
more control over a printer than you would
get with a regular driver. FastRIP now
makes the following possible:

 Preview of printable images

 Control over the amount of ink used

 Faster print speeds than with a normal print driver
FastRIP is extremely easy to use and is almost transparent when working with the T-
Jet2.

For details on installing FastRIP, consult the
FastARTIST User’s Manual.

It is important to have a brief knowledge of both
FastARTIST and FastRIP. The manuals may seem
very large but don’t be concerned by the size. 
You do not have to know everything about
FastARTIST and FastRIP.
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Chapter 4

Computer Graphic Software
Computer Graphics Overview

In order to print a good-looking image on a shirt, you will first need a good/great
piece of artwork. The customer typically has no idea about the type or quality of
artwork needed so you are often stuck with inferior artwork. If you don’t have 
computer graphic experience, you might print this bad artwork and then blame your
T-Jet2 for the poor quality image.
There are a number of great computer graphics programs designed for creating and
manipulating images. If you have never used computer graphic programs before,
you might be inclined to use applications such as Microsoft Word or other word
processing programs that are designed for text and are NOT strong graphic
programs. Recommended graphic programs for this purpose are FastARTIST
(included with T-Jet2), Corel Draw (any version), Adobe Photoshop (version 5.5 or
higher), Adobe Illustrator (version 7.0 or higher), and Macromedia Freehand (any
version).
Contrary to popular debates, great images can be created and manipulated on
Windows/PC as well as the Mac platform. The T-Jet2’s FastARTIST graphic
application is designed for Windows/PC’sonly. Mac users wanting to take advantage
of the FastARTIST Underbase Wizard and other convenient setup options will simply
need to transfer the file onto the T-Jet2 PC loaded with FastARTIST and import the
image.
We often hear from first time T-Jet2 users that did not think they would need to know
about graphics software. This is not the same as taking your digital camera’s 
memory card to the drug store and getting pictures made. Yes it would seem that
simple and it CAN be, but in the world of T-Shirt printing there are many variables.
The first variable is that the customer will often bring artwork that is substandard and
could often times be an image that their web designer gave them. Web graphics are
commonly very low resolution (not sharp) and may need to be enlarged for a full-size
T-Shirt image. When you have an image that is of low resolution at a small size,
enlarging the image will only blur the image more. So for this, you will need to learn
how to make the file the correct size plus how to improve the quality of the file.

Vector programs
Currently there are two main types of graphic
programs–Vector and Bitmap. FastARTIST, Corel
Draw, Adobe Illustrator, and Macromedia
Freehand are called vector programs. Vector
programs create images based on shapes
somewhat like a coloring book. They typically have
hundreds or even thousands of typefaces and
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manyhave extensive “coloring book” type stock clip art that you can use to create
artwork.
Vector programs are generally used for images with a hard edge like racecar
designs, school mascots, corporate logos, etc.

Pixel based bitmap programs
Programs like FastARTIST and Adobe Photoshop
are called pixel or raster based programs and like
to work with photographic type images. Yes,
FastARTIST is both a bitmap and vector graphic
program. Bitmap applications can lighten, darken,
sharpen, and create images. Photoshop is a
common graphic program used by many for
manipulating images but FastARTIST also contains similar editing tools. Images with
lots of gradations or that are photorealistic are generally created and manipulated in
programs such as FastARTIST and Photoshop.

Both File Types
If you intend to create your own artwork then you will need a vector and bitmap
program. The vector program will be used for working with shapes, text, and edges,
while the bitmap program will be used for any photographic or detailed image. The
FastARTIST program will work with both types of images.
The following section gives tips and suggestions for creating artwork suitable for
printing on your T-Jet2. Remember, if you are proficient in a graphics program other
than the new FastARTIST; simply create the images where you are comfortable. For
advanced users of programs such as Photoshop and CorelDraw; the entire image can
setup to print directly to FastRIP including images that need a white underbase.
Please note that highlight white (not to be confused with the white underbase) is not
available when printing from another program other than FastARTIST.
FastARTIST can be used to create the entire image if needed. With Corel and
Photoshop type tools, FastARTIST is a quick learn for those already familiar with
other graphic programs.
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FastARTIST/Photoshop - Editing Bitmap/Pixel Based Artwork
Besides FastARTIST’s ability to work with vector based images such as hard edge
graphics, clipart, and font manipulation, it will do a lot of basic pixel editing functions
necessary when the customer gives you a pixel/bitmap files such as: JPG, GIF,
TIF, or PSD.
One of the main T-Jet2 strengths is the ability to print short runs of photorealistic
images. If your customer wants a picture of the entire team on a shirt, no problem
because you can’t do a short run of photorealistic images profitably with screen
printing!
The problem in the T-Shirt business is that customers need high resolution art
images and often all they have to work with is small artwork that is low resolution. It
is MANDATORY that you learn how to make the artwork the correct size and
resolution, besides knowing how to make the image brighter (most images are dull)
with good color saturation. This may be the ONLY time you utilize the FastARTIST
or Photoshop image editing tools.
A quick note about Photoshop
As you begin to work with different kinds of
images in different formats and resolutions,
it is very important to have the proper tools
necessary to clean up and make images
print ready. As FastARTIST is a very
powerful graphics program, there may be
circumstances when a program such as
Photoshop is required based on specific
editing functions. Photoshop works hand-in-
hand with FastARTIST making it a very
complimentary program to have when
working with bitmap images.
The goal here is to get you up to speed with basic image editing, so that you may
print the best looking images possible. When first learning graphic programs such as
FastARTIST and Photoshop, the process mayseem a bit overwhelming. Don’t be; 
just keep in mind the age old 80/20 rule as it applies. You use 20% of the program
80% of the time but in this case it’s actually more like the 90/10 rule.

You might be asking why you need Photoshop if you have FastARTIST. Actually,
you can do almost everything you need with FastARTIST but Photoshop is much
more powerful when creating an image with lots of photographic components. Plus,
Photoshop is much more powerful when fixing and cleaning up poor quality artwork.
Note: The techniques shown below will be performed using FastARTIST as the key
graphic program. When appropriate we will show you Photoshop steps as well. For
more detailed FastARTIST information, please consult the FastARTIST Users
Guide.
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Where to get Photoshop
Photoshop is the flagship product of Adobe Systems at www.adobe.com. The
program retails for around $650 and as of this writing, version 9.0 CS2 is the most
current version. It is always nice to have the latest and greatest version, but frankly,
you can do everything we show here with version 5.5 or higher. If you are a student,
teacher, or work for a school, you may be eligible for an “educator version” from 
places like www.academicsuperstore.com.

File Types and Resolutions
FastARTIST and Photoshop will let you
“Open” a wide variety of files including, TIF, 
JPG, GIF, EPS, PSD, AI and others. If you
open a file that is vector based like one
from Adobe Illustrator, Photoshop will
convert the file from mathematical vectors
to small pixels. This is called Rasterizing a
file.
The important point here is to keep the file
resolution high enough for the image to
remain sharp. It is generally taught that a
file needs to be at 300 dpi at the final size in
order for it to remain crisp. In T-Shirt
printing, you can get away with file
resolutions of 150 to 200 dpi at the final
size. The default setting for opening vector files in Photoshop is 72 dpi. The picture
at the right shows a magnified view of a file that is 300 dpi (bottom) and one that is
72 dpi (top). Obviously, the 72 dpi file will be softer.

Check File Mode
This is step that most new users will over look when opening a file. It is very
important to learn about the file attributes when first opening a file as well as
determining the file mode: CMYK or RGB. File should be in RGB as the T-Jet2 does
not print spot color.
In FastARTIST, even if the file is CMYK from another application, FastARTIST will
open/import it as RGB, but FastARTIST will open the file at a larger resolution than
normal. For best results convert the file to RGB (if you can) before you import it into
FastARTIST.
Yes, Photoshop will do process color separations called CMYK, but for file
manipulation and adjustment you should work in RGB mode. In Photoshop, to see
the Mode of the file go to Image/Mode. If CMYK is checked, click on RGB.
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Check File Size and Resolution
Next, you MUST know the actual resolution and
size of the image. Otherwise you could be working
on a very small file and not know it. In
FastARTIST, import a photorealistic file and click
on the Bitmap main drop down menu and then
Image Size. You will see the actual size of the
image. If the resolution is too small, change the
size and click on Apply. Remember that an
appropriate image size should be 150 to 200 dpi.
If the images physical size is too small, resize the
image before changing the resolution. After the
image size is adjusted, click on the Bitmap main
drop down menu and then Image Size. Change
the resolution and select Bicubic (as shown below), click Apply.

In Photoshop, go to Image > Image Size. If it says pixels per CM, change this to
inches and then enter the images intended final print size. Re-adjust the Resolution
and make sure that Bicubic is selected as shown below. The physical size should be
the final print size.
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If you have an image that is very low resolution, your only real choice is to change
the image size and resolution referred to as Upsampling. Photoshop “Upsamples” 
the image, but in doing so, has to guess at where to place all the extra pixels and
what color to make the pixels. Images may have softer edges when upsampled, but
will be less pixilated! If you can get a higher resolution file from the client, by all
means do so If a small resolution image is all you have to work with then so be it..
Corel Draw and Adobe Illustrator have similar Image Size functions.

Important Point!
If the original file is low resolution and not

the final size, you need to upsample the file
to the final print size and 150 to 200dpi (150
is OK for photos and images without hard
edges. 200 to 250 is better where there is
type or hard sharp edges). Now, you can
work on the file and add additional type or
other elements. The reason to upsample the
image first is so any additional elements you
add will be at the higher resolution. If you
aren’t sure if the image issharp enough,
simply zoom in on the file. It might look
great zoomed out but very soft or jagged when you zoom in. It will print the way you
see it zoomed in.

Check file Saturation
Quite oftencustomers’images will be flat and need a color boost. Always check the
file to see if it needs a saturation boost by going to Bitmap > CMYK Color
Adjustments > Hue Saturation (FastARTIST) or Image > Adjustments > Hue
Saturation (Photoshop).
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Sharpening Images
Typically, an image can be made sharper. Even if the file came from an agency or
large licensed job, don’t assume that their artist knew your needs. Imagesthat are
printed not only get darker, but also get softer. You MUST make them as sharp as
possible.
Go to Bitmap > Filters > Sharpen > Unsharp Mask (FastARTIST) or Filter > Sharpen
> Unsharp Masking (Photoshop).Don’t let the “Unsharp” term fool you, this term
came from the old process camera days and basically means it only sharpens areas
of high contrast. The reality is, it sharpens but keeps it less apparent that you have
sharpened the image.
Move the Amount slider to 150%. Set the Pixel Radius to 1 and the Threshold to 8.
How does the image look? To compare the original to the sharpened version,
uncheck the Preview check box (Photoshop). Click it on and off and compare the
results. If you can't see much difference, move the Amount slider higher. Go all the
way to 500% if you need. Don't make the image too grainy.

Set the Amount slider to 200, the Radius to 1
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Using the Tone Curve
When screen printing, heat transfer printing, or direct-printing on garments, images
tend to get a little muddy. If you have a file with lots of detail in the shadow areas,
this will probably be lost when printed so you need to adjustthe “density levels” of 
the image. In FastARTIST go to the Bitmap main drop down menu, and then to
CMYK Color Adjustments > Curves. In Photoshop go to the Image main drop down
menu, and then to Adjustments/Curves. The Tone Curve is a very powerful tool that
will allow you to adjust specific tonal areas from the lightest “highlights” to the 
darkest “Shadows.” By placing your cursor in the middle of the “Midtones” curve and
dragging the mouse up or down, you can lighten/darken the medium or midtones in
an image. By clicking on the very top corner and dragging the mouse in, you can
make the highlights lighter (Photoshop). Play around with the Tone Curve and see
what happens. A good curve for flat images is a slight “S” where you lighten the 
highlight 25% area and darken the 75% shadow area.

Bitmap Editing in FastARTIST
Photoshop is always in bitmap editing mode
because it is a pixel-based bitmap-editing
program. FastARTIST is in vector editing
mode when you launch the program (so is
Corel Draw and Adobe Illustrator). You need
to find the bitmap editing tools in other
programs. In the case of FastARTIST,
simply double click on the image. That
changes the top tool icons to standard
bitmap editing tools (very similar icons to
Photoshop).
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Selecting Areas
If you want to apply a Tone Curve adjustment or apply Unsharp Masking to select
areas, in FastARTIST you simply double-click on the object to have the bitmap tools
available and then click on the Lasso tool (looks like a lasso). Now, simply hold the
mouse button down and draw around an area you want to change. When you
release the mouse, you will have a yellow outline identifying the selected area. Now
anything you do ONLY happens to this area.
Using Photoshop, you can choose an area with one of the Selection Tools on the
Toolbar. Click on the tool that looks like a Lasso
and draw around the object while holding down
the left mouse button. When the left mouse button
is released the selected area will be identified by
what is called “Marching Ants” –small moving
lines around the selected area. While the area is
selected, any changes made with regards to Tone
Curve or Unsharp Mask will only apply to this
area. To remove the marching ants, go to the
Select pull down menu and to De-Select. If you
want to select square or round areas, use the
Marquee Tool (top left tool) as this will do the
same as the Lasso tool.

Channels and Layers
What really separates Photoshop from
FastARTIST and Corel Draw is the ability to work
in Layers to build images. In Photoshop, if you
setup the working space the way we showed, you
should have the Channels Palette and Layers
Palette open. People always get these confused.
Here are the rules. The Channels Palette is used
to create output. Channels print. The Layers
Palette is used to create or build the image. You
use the Layers Palette to put various components
together including adding Type to an image.
Layers don’t print. Simple….

You will notice that your Channels Palette shows
four channels: RGB, Red, Green, and Blue. Your test file probably shows only one
Layer called Background.
For more details on using the Layers Palette in Photoshop consult the Photoshop
manual.
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Setting Transparent Images in FastARTIST

To set transparent backgrounds in FastARTIST double click on the image to
enter the bitmap edit state.
This is done simply by double clicking on
the image in the workspace.

Using the Eyedropper tool, click on the
red background and then click on the
Add Color button in the Color Selection
dialog box. This will make the selected
Red the current color.

Note: The background color can be any
solid color, not just red. For example it
can be white, black, yellow, green, etc.
Please also note that FastARTIST will only remove one color only and if your image
has a multicolor or gradient back ground, Photoshop would be necessary to make
the image print ready.

To make the red transparent click on the Eye
icon next to the selected color (this acts as a
toggle switch so selecting it again will de active
any transparent color).

Note: It is only possible to have one color set as transparent.
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Removing Backgrounds with Photoshop
In order to make removing backgrounds as easy as possible, try to maintain a
consistent/neutral background if possible. For example, if photographing the
motorcycle as shown below, park in front of a wall or a background that contains a
much lighter color than the bike. This will help Photoshop determine the difference
between the selected background and the intended object (such as the motorcycle)
to keep.

Using the Magic Wand - Click and Delete
With the Magic Wand you simply click on the
neutral areas around the image. It works best
if the background color is slightly different
than any of the edges of your image. Just
click and watch the Magic Wand make a
selection around the image. If the “marching 
ants” selection goes into the main design, 
change the Tolerance on the Property Bar.
The default is 32 pixels.
Photoshop and FastARTIST both have
Magic Wand tools (it looks like a wand with a

sparkler on the end).

Using Extract Filter
Photoshop also has a Filter called
Extract where you draw around an
image and then fill the center with color
and Photoshop removes all the areas
around the image leaving you with a
transparent background. Extract works
OK but the magic wand is preferred.

Note: The Magic Wand and Extract filter perform best when the background is a solid
color and not gradient. For gradient images, please see the following–Preparing
Images with Gradient Backgrounds.

Making Your Selection a New Layer
In Photoshop you need to get your main
image on a layer with a transparent
background (this will show as checks all
around the image). With a transparent
background you can add additional elements
to the image including type, drop shadows,
glows, and more.
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Preparing Images with Gradient Backgrounds
Occasionally you may need to prepare an image to print that contains a gradient
background. As this will not be an issue when printing on white/light colored
garments that do not require an underbase; however, setting up a gradient image to
print on dark colored garments that require an underbase can sometimes be a tricky
process. In order to process a gradient image within FastARTIST, you will need to
create two versions of the same image–one with a white background and the other
with a black background.

If the customer supplies you with a Photoshop PSD file that has been created in
layers, then the process of changing the background color can be very simple. But if
the image is a flattened image such as a jpg or tiff, the process of changing the
background color can be much more involved especially if the edges of the image
fade into the background such as the example above. For the purpose of this
manual we will assume that the customer supplied a flattened jpg.

The ability to maintain the gradient look (for dark garments only) will require the use
of both Photoshop and FastARTIST combined in a two part process. The first part
will be to setup the image within Photoshop, then create the underbasing within
FastARTIST for the second part.

The image that that we will be working with contains a
white background that will need to be changed to black in
Photoshop in order to have the same image both in a
white and black background. Make sure to duplicate the
image creating a safe working copy.

Steps for changing background color
There are many ways to change the background of an
image when using Photoshop. Earlier in this chapter we
discussed using the Magic Wand or the Extract filter. In
this case we will be using the Magic Wand in combination with the Replace Color
filter to change the background color.
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Note: It is very important to understand before continuing that not all images created
on a white back ground will look the same on a black background. Through hours of
Photoshop experience you will learn to use the tools mentioned below to get the
best representation possible.

1. Open the safe working copy of the image in
Photoshop.

2. Once the file is open, select the Magic Wand tool
and set the tolerance to 55 as a starting point.
Please note that the higher the tolerance is set,
the tighter the selection will be to the image.

3. Make sure that the Anti-alias and Contiguous
boxes are selected to the right of the Tolerance
setting.

4. With the Magic Wand tool, left click the white
area around the image. The selected white area
will now be identified by the marching ants.

5. Next, from the top main menu
select Image > Adjustments >
Replace Color. The Replace
Color filter window will now
display as follows:
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6. Change the default settings for the Replace
Color filter:

 Black will be selected as the color–Move the
mouse over the white selected area of the
image and left click. You will notice that the
color box within the Replace Color window
will now show white.

 Within the Replacement Box move the Lightness slider all the way to
the left (-100) watching the result box change from white to black. Your
image should also reflect the change as you move the slider. If you do
not see the image change, make sure that the preview box is selected.
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 Adjust the Fuzziness slider to change the softness of the selected
edge. Adjust at your own discretion.

 When the finished adjusting the Replace Color setting, click OK.

7. With the Magic Wand tool still selected, right click on the image and
choose Deselect from the drop down menu.

8. Save the image with the “Save As” option as a jpg. Be sure to use a
different file name as not to overwrite the original image with the white
background.

At this point you now have the two files necessary for FastARTIST to create a
gradient underbase–One image with a white background and the other with a black
background as shown below.

Creating a Gradient Underbase with FastARTIST
1. Open FastARTIST and import the two images onto your workspace.

2. Select Edit from the top menu bar, then Select All.
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When both images are selected they will be boxed in as identified above.

3. Click on the Underbase/Highlight Wizard icon from the tool bar and select
the wizard option.

 First option - Underbase/Highlight Wizard will manually take you
through the underbase/highlight setup process.

 Second option–Heavy Underbase. This is a one click wonder button
that will automatically complete the underbase process for you.

 Third option–Normal Underbase. This is a one click wonder button
that will automatically complete the underbase process for you.

 Forth option–Last Setting. Performs the underbasing process with the
last used setting from the manual Underbase/Highlight Wizard.

4. After selecting one of the four Underbase Wizard options, the Underbase
Wizard window will open identifying the two images selected. Within this
window it is important that the image with the white background is on the
left and the black background is on the right. If the images are reversed,
click on the down arrow in the lower right hand corner of the image to
select the proper image. Please see the following example:
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5. After images are properly orientated as shown above, click Finish.

For more in-depth information regarding Photoshop/FastARTIST and any of the
steps listed above, please consult the individual user manuals.
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Fixing Bad Line-Art in Photoshop and FastARTIST
You can also use a bitmap editing
program to improve the quality of bad
artwork. We talked earlier about the file
resolution. A low resolution file will have
very jagged edges. By simply upsampling
a file to a much higher resolution you will
have less of a jagged effect, but a softer
edge. For black and white images you can
upsample and then apply a Tone Curve to
make edges black and white without any
“gray” areas. This process is available in 
FastARTIST, Photoshop, Corel Draw, and
Adobe Illustrator.

 Full-color images set to 200dpi.

 Black and white set to 500dpi.

Artwork for Light and Dark Garments
To properly setup artwork, it is imperative to know first what color garment the image
is to be printed on. This will then determine if the image background needs to be
transparent, white, black, or is some cases both black and white.
For light colored garments, the T-Jet2 will print the image just as it appears but does
not print the white. If you require white in the image it will be necessary to underbase
the image. Printing in color without an underbase is the easiest form of garment
printing.
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Dark colored garments will always require an underbase that allows the colors to
stand off the garment. You may setup the underbase using FastARTIST or the
graphics program of your choice. When printing a graphic that contains gradients on
a dark colored garment, you must the have to versions of the same image: one with
a white background and the other with a black background. The two images will then
need to be processed in FastARTIST to achieve the desired result.

Important Point!
You must take ownership of fixing bad artwork. If the file is provided as a pixel based
format like TIF, PSD, JPG, GIF, etc., you can’t assume it is bright, sharp, high 
resolution and ready to print. You must - check the resolution and upsample the file
if necessary, see if it needs sharpness or boost color saturation if the file is dull, and
lighten the file if it seems too dark. Image may print darker!
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Chapter 5

Printing with the T-Jet2
Your T-Jet2 is very easy to use. Simply create an image in your favorite graphics
program, load a shirt on the printer, choose the appropriate Print Mode (printer
resolution, number of passes and how much white ink to deposit), and press the
Print button. Instant shirt! By now you know many of the basic parts of the printer;
the following chapter is more of an in-depth look at the T-Jet2.

Control Panel Buttons and Lights

5
1
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Power Button
This button turns the printer on and off. The button also flashes while the printer
initiates movements such as: self-cleaning, ink cartridges changing, data processing,
and printing. When the printer is ready to print, the button will stop flashing and stays
a solid color green.

Error Eject Button
This button ejects the printer tray when there is an error in the print data.
Note: The Error Eject button is rarely used - only press this button when the printer
is in the loaded position.

Ink Button
Press this button to move the print carriage to the ink cartridge changing position
(The Power button flashes while the printer heads move to this position). After
changing the Ink cartridges press the Ink button again and the print carriage will go
back to its original position. Press and hold this button for 3 seconds to begin a head
cleaning.

Load Button
After the T-Jet has powered up the load button will light up, pressing this button will
move the print bed into position to start printing. When the Load button turns on
again the printer is ready to print.

Eject Button
This button ejects the printer tray. After the tray is ejected the button will light up.

Ink Lights (1-7)
Each red ink light indicates the status of the
corresponding ink cartridge. Flashing lights
indicate the ink cartridge is low on ink. As
covered in the Bulk Ink System section of
this manual, you should never be out of ink.
If any of these lights stay on, shut the printer
off for 60 seconds. When you turn the printer
back on the lights should all be off.
Note: If All Lights start to flash fast, it means
that there is an error in the printer’s 
mechanism. If this happens, you can try the
following: The flashing lights can indicate the
maintenance tank needs to be emptiedbut it also can mean the printer’s head can’t 
find “home.” The print head is basically lost. This can happen if the capping station 
has moved out of place and blocks the head from finding home or if the thin strip
(encoder strip) that the head reads for location is dirty. The speed of the flashing
(fast or slow) means different things.
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Turn off the printer. Open the printer cover and check the inside for any objects
blocking the printer head, see if the encoder strip is dirty, etc. If the error continues
call our support department.
Note: If the lights alternately flash the printer needs special adjustments. If this
happens you can try the following.

Turn the printer off and on again. If the error continues call our support department.
Please refer to Trouble Chapter (pg. 144) of this manual for other solutions to
blinking red lights.

Basic Steps for Printing a White Shirt
OK, the time has come. You should have installed the bulk system and performed 3
to 4 head cleanings by pressing the ink button for three seconds (each cleaning).
You should have created a simple image in your favorite graphics program and
should be prepared to ruin a few shirts. Yes, it is ONLY a shirt and you must get
over the fact that they get ruined. It is a fact of life in the garment decorating
industry. For less frustration you should perform nozzle checks to guarantee that all
the heads are firing and there are no clogs.
There is a slight learning curve to printing a shirt. In the beginning you will worry
about the print placement and getting the image in the graphics program coordinated
to the correct location on the shirt. You should start off by using clean rag shirts, or
just accept the fact that you will ruin a few new shirts and buy some extras. Your
printer will also need to be “broken in” a little. When you first install the bulk system,
there is a chance not all the inksare flowing yet. You won’t reallyknow this until you
have done a print or two, or a nozzle check. Your first print may NOT be a winner,
but after you have printed a few shirts you will be like an old pro. This is not exactly
plug-and-play.
1. Press the Power button to turn T-Jet2 on. The printing bed should be fully

ejected to the Eject end of the machine. The Eject end is the side of the machine
with the chrome T-Jet2 emblem on it. Although you can move the printing bed by
hand (you will feel a little drag on it), try to ONLY use the buttons to move the
bed.

2. Shirts can be full of lint. Some shirts
have more lint than others. Lint is NOT
your friend. It can get on key
components inside the T-Jet2. For best
results grab a blank shirt by the
shoulder seams and give it a little shake
before you lay it on the shirtboard. This
will actually help pull out wrinkles as
well.
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Lay the garment on the Shirtboard. Place the metal Holding Ring over the
garment and flatten out the printing surface. Stuff any excess garment into the
space between the top and bottom of the shirtboard. If the garment is overly
large or a thick material like fleece, you can eliminate using the holding ring and
just lay the garment on the shirtboard and push the excess material into the
space between the shirtboard.
The bottom of the shirtboard is 1” (2.54cm) longer than the topon one side. This
longer end is where the TOP/Collar of the shirt it loaded. The longer bottom piece
helps allow room to reach your fingers in and pull the holder out when done
printing.

For best results DO NOT let the collar or seams set on top of the shirtboard, the
head may strike them when printing. Make sure that the collar is far enough over
the shirtboard and out of the way.

3. Press the Eject button on the Control Panel. The bed needs to be completely
ejected out towards the front of the printer before loading.
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4. Place the shirtboard in the Printing Bed. Make sure there are no parts of the
garment keeping the shirtboard from laying flat.

Important Point!
When creating graphics in your graphics program using a standard page setup, the
upper left part of the image is the “zero” point for the printing bed. When you are
facing the T-Jet2, the lower right corner of the bed is the same as “zero” in your 
graphics program. You should always create artwork using the same “page” size 
as the shirtboard. The standard shirtboard is 13” x 18” (33 x 46cm). Remember to 
allow for the extra 1” (2.54cm)of garment holder border when designing images.

When creating images in FastARTIST, you can choose the actual shirtboard size
and FastARTIST allows for the size of the holder ring. In that case the lower right
inside corner of the holder ring is the zero point as identified below.
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5. Use the Height Clearance Guide to make
sure the printed object sits just below the
top of the printing bed. Adjust the printing
bed height with the Up/Down dial on the
front of printing bed to make sure there
are no wrinkles or seams setting higher
than the top of the printing bed. The bed
should be set so the garment is about
1/16” (.16cm) below the Height
Clearance Guide. If the garment is too
low, or the shirtboard not level the image
will appear out of focus.
It is VERY IMPORTANT that the printing
head DOES NOT hit the garment or the
garment holding ring.
If the head hits the holding ring you may have to do a head alignment. A more
serious “crash” of the head may require a head replacement. If the head brushes
across a garment you will need to do a head cleaning cycle before the next print.
Earlier models of the T-Jet2 had rulers attached to the printing bed. These have
been removed on newer models to the
height fixture making it easy to measure
print locations. If your height fixture does
not have a ruler, keep one close to the
T-Jet.

When printing white ink on shirts that
have been pretreated, it is VERY
IMPORTANT that the print head does
NOT hit or even brush across a
pretreated garment. The pretreatment causes a reaction to the pigment in the
ink and the ink will permanently clog the head!

6. To move the bed into the printing
position, press the Load button. The
printing bed will move into the unit.
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The T-Jet2 has a light beam sensor that will stop the machine if the light beam is
broken by a shirt or the holding ring. If the Load button is flashing there is
something in the way. If you are printing, lower the bed slightly or remove or fix
the obstruction and press the flashing load light.

The sensor light turns from green to amber when there is an obstruction.

7. Create or choose the artwork to print. You
can print to the T-Jet2 in a variety of ways.
You can print direct to FastRIP from your
favorite graphic application or from
FastARTIST (preferred). Consult the
FastARTIST User’s Manual for easy-to-follow
directions.
Make sure the image is the correct physical
size and that you have placed it in your
graphics program on a “page” that is the same size as the printing bed.
The easiest way to get the correct print placement is to work on a 13” x 18” (33 x 
46cm) printing page for your layout. Keep in mind that inkjet printers need a slight
margin and the metal holding ring takes up some of the page size. Make sure the
image is not larger than 12” x 17” (30.5 x 43cm) and center the image on the
page. If you need to print an image that is wider than 12” (30.5cm) you can rotate 
the image in the graphics program and load the shirt side-ways on the shirtboard.
You can print up to 12.5” (31.75cm) without using the holding ring.
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8. Select the appropriate Print Mode. There is a wide variety of Print Modes in the
FastRIP software. Print Modes give you the advantage of printing higher quality
images (slower speed) when needed or to print low quality simple spot color
images (faster speed) when needed. Ready to print! Now select the Print
command from your favorite program. Choose the T-Jet2 as your printer. If
printing from FastARTIST, consult the FastARTIST manual.

A Word about Resolutions, Speed and Quality
You will notice that each Print Mode has various resolutions. The resolution that you
choose will not only determine the print quality but the print speed as well. If you are
going to use a low print resolution such as 360dpi you will achieve a much faster
print speed. This is due the fact that lower resolutions apply less ink dots per inch
(dpi) which allows the print head to move much faster, but may not offer the quality
needed for printing photo images. The print heads must also be perfectly aligned at
this resolution or you will start to see banding in your print. Banding is small
horizontal lines that run across the entire image. For most images 306dpi will be fine
but depending on the graphic image you may want to increase the resolution.

If you intend to use higher print resolutions such as 720 or 1440, you will notice a
decrease in speed but an improvement in print quality. Print quality and the amount
of ink dispensed directly relates to the dpi (dots per inch). A higher dpi will increase
print quality and amount of ink but at the same time slow down the print speed. We
suggest a lower resolution for cartoon images and a higher resolution for photo
images.

Print modes that contain “HS” (CMYK Cartoon 360 2 pass Standard HS) at the
end are bi-directional print modes. This means that the print head will now print in
both directions as compared to the standard unidirectional print mode that just prints
in a single direction. Bi-directional print modes are twice as fast as unidirectional and
will increase your print speed especially if using a higher resolution. You must be
careful nevertheless, to watch for banding/shadowing when using any bi-directional
print mode as it absolutely necessary that the print heads are perfectly aligned.

Print Modes and FastRIP
In the beginning the number of Print Modes may seem like too many choices. Once
you start to print jobs you will see that they are not that hard to use and you will
quickly find the Print Modes that work best for you.
We have three basic types of Print Modes–Cartoon, Photo, and Underbase.

CMYK Cartoon and Photo Print Modes
The Cartoon and Photo Print Modes will print the image in color when printing from
FastARTIST or any other graphic program. Two print mode options have been
created to adjust the print characteristics based on the image to be printed. If you
are printing vectored graphics with spot color then use the Cartoon Print Modes, but
if you are printing photo type bitmap images, use the Photo Print Modes.
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The difference is, Cartoon Print Modes are design to lay down more ink with good
color saturation, whereas Photo Print Modes are design to lay down less ink with
accurate colors. Cartoon Modes should be used for non-critical images and as such
a lower dpi can be selected. Photographs, because of the image detail, need to be
treated differently. When using Photo Print Modes, select a higher dpi to insure a
good print quality.

CMYK Print modes
Cartoon

CMYK Cartoon 360 2 pass Standard
CMYK Cartoon 360 2 pass Standard HS
CMYK Cartoon 360 Standard
CMYK Cartoon 360 Standard HS
CMYK Cartoon 720 2 pass Standard
CMYK Cartoon 720 2 pass Standard HS
CMYK Cartoon 720 Standard
CMYK Cartoon 720 Standard HS
CMYK Cartoon 1440 Standard
CMYK Cartoon 1440 Standard HS (Bi-directional)

Photo
CMYK Photo 360 2 pass Standard
CMYK Photo 360 2 pass Standard HS (Bi-directional)
CMYK Photo 360 Standard
CMYK Photo 360 Standard HS (Bi-directional)
CMYK Photo 720 2 pass Standard
CMYK Photo 720 2 pass Standard HS (Bi-directional)
CMYK Photo 720 Standard
CMYK Photo 720 Standard HS (Bi-directional)
CMYK Photo 1440 Standard
CMYK Photo 1440 Standard HS (Bi-directional)

Underbase Print Modes
Underbase Print Modes are selected when printing from the FastARTIST program
only. With Cartoon and Photo Print Modes in three different resolutions, you have
the ability to select the proper print mode to match your graphic image. For dark
shirts try using the 1440dpi print mode to achieve a stronger more consistent
underbase. This is due to the fact that the 1440 dpi resolution will dispense more ink
at a slower speed creating an extremely even coverage. If you are printing lighter
colored shirts it may not be necessary to print such a strong underbase so the
720dpi or 360dpi mode may work better.

Underbase
Underbase Cartoon 360
Underbase Cartoon 360 HS (Bi-directional)
Underbase Cartoon 720
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Underbase Cartoon 720 HS (Bi-directional)
Underbase Cartoon 1440
Underbase Cartoon 1440 HS (Bi-directional)
Underbase Photo 360
Underbase Photo 360 HS (Bi-directional)
Underbase Photo 720
Underbase Photo 720 HS (Bi-directional)
Underbase Photo 1440
Underbase Photo 1440 HS (Bi-directional)

Windows Underbase
The following Windows Underbase print modes are selected when printing from
graphic programs such as Adobe Photoshop, Corel Draw, or Adobe Illustrator. There
are four print mode options: Image Heavy, Image Normal, Vector Heavy, and
Vector Normal each with different resolutions. Bi-directional is also offered
for each print mode as well.

Select the Image mode when printing a bitmap/raster or gradient images. This also
applies when printing a gradient image in a Vector program. Anytime you have some
sort of a gradient in any image regardless if the image is mainly spot color, the
Image mode must be used.

The Vector mode is to be selected when printing solid vector images. With the
Vector mode you will be able to print the white areas as a Highlight white on the
color pass. This only happens if you use named spot colors and apply the named
color white. The spot color white image area with a print white and is only available
with vectors solid spot colors only.

Heavy and Normal Underbase change the intensity of the underbase. The Heavy
Underbase modes use a preset heavy underbase applying more ink in dark and light
areas then the Normal Underbase that applies less ink. Because underbasing is
such a curtail part of the image quality, we recommend trying out the different print
modes to get a general understanding of the difference between each one.

Windows Underbase
360dpi Image Heavy underbase
360dpi Image Heavy underbase HS (Bi-directional)
360dpi Image Normal underbase
360dpi Image Normal underbase HS (Bi-directional)
360dpi Vector Heavy underbase
360dpi Vector Heavy underbase HS (Bi-directional)
360dpi Vector Normal underbase
360dpi Vector Normal underbase HS (Bi-directional)
720dpi Image Heavy underbase
720dpi Image Heavy underbase HS (Bi-directional)
720dpi Image Normal underbase
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720dpi Image Normal underbase HS (Bi-directional)
720dpi Vector Heavy underbase
720dpi Vector Heavy underbase HS (Bi-directional)
720dpi Vector Normal underbase
720dpi Vector Normal underbase HS
1440dpi Image Heavy underbase
1440dpi Image Heavy underbase HS
1440dpi Image Normal underbase
1440dpi Image Normal underbase HS
1440dpi Vector Heavy underbase
1440dpi Vector Heavy underbase HS
1440dpi Vector Normal underbase
1440dpi Vector Normal underbase HS

If you are printing to a standard seven color (cyan, light cyan, magenta, light
magenta, yellow, black, light black) Red T-Jet or a T-Jet2 that DOES NOT HAVE
WHITE INK CAPABILITY, you will be using the standard EPSON printer driver and
you will NOT be using these Print Modes. Consult Appendix A.

Ink bleeding can be a problem when printing on absorbent material. If you lay down
too much ink in one pass, you will get great color saturation but there might be slight
bleeding between colors and into the surrounding shirt.
Note: You can minimize bleeding by preheating the shirts in a heat press for a few
seconds to dry them out.
In some cases you will need to do TWO print passes to get good color saturation
and minimize bleeding by choosing a 2 Pass Print Mode. The 2 Pass Mode does
not lay down twice the amount of ink but allows the first pass to dry slightly before
the second pass is printed–for less bleeding and brighter colors.
At higher resolution, the printer prints at a slower speed.
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1. After T-Jet2™ finishes printing, the
printing bed will eject from the unit.
For brighter prints, double print the
image by pressing the Load button
and printing from the application a
second time. For higher production
you can set the number of “pages” 
to print from the application to a
high quantity or you can choose a
2-pass print mode.

Remember that if you tell the
application to print dozens of
copies, the program might build a very large print file that will slow down your
computer.

Newer T-Jet2 printers have an automatic Print Pass Counter that can be set for
the number of print passes. This is very helpful when printing on dark shirts
where two or three passes are necessary. You can set the counter and walk
away and come back to a finished shirt. See the Print Pass Counter Directions
later in this chapter.

2. Remove the holding ring by slipping your
fingers in the gap at the front of the
shirtboard and pull out of the bed. Carefully
remove the holding ring and remove the
garment from the shirtboard.

3. Finished prints must be heat cured to fully set the ink.
Prints should be cured through a conveyor dryer or
with a heat transfer press with the following settings:

Light Garments
(With or without using FastBRIGHT)
Cure Time: about 60 seconds with light pressure
(enough pressure to where the curing paper is snug
under the press and can’t be pulled out) 
Cure Temp: 330°F (166°C)
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Dark Garments
(using FastBRIGHT or the normal pretreat solution)
Cure Time: about 180 seconds with light pressure (enough pressure to where the
curing paper is snug under the press and can’t be pulled out) 
Cure Temp: 330°F (166°C)

Some shirts may scorch if cured too long. A heat press will give more a more
even cure and when printing with white ink, you will see less shirt fibers sticking
up through the ink.

4. You must perform a head
cleaning if you experience one of
the following conditions: If streaks
appear in the print, small drops of
ink get on the garment during a
printing cycle, if the unit has been
setting for a few days, or the
printing head hits the garment.
Press the Ink button for three
seconds to have T-Jet2™ go
through a head cleaning cycle. If you experience severe head clogs you can do a
number of head cleanings back-to-back. You can perform a head cleaning while
the unit is printing a job by simply holding down the Ink button for three seconds.

If you have any problems printing, consult Chapter 8 or Chapter 9 to solve
print issues.

The best way to check the print quality is to do
a Nozzle Check from the Epson 2200
Maintenance window.

1. Right click on the printer icon located
in the system tray.
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2. Left click on Nozzle Check
within the popup menu.
Follow the instructions for
performing a nozzle check.

If you have been printing a lot of
shirts and if some of these shirts
have been set so high that the
printing head brushes against the
garment, you may have to actually
wipe the bottom of the head to
remove cotton lint.

It is hard to see the white ink when doing a standard nozzle check on a light shirt or
piece of paper. Conversely it is hard to see the colors on a dark background. Raise
the printing bed all the way to the top position and use a piece of clear overhead
transparency film or our FastPOSITIVE Waterproof inkjet film (used to make screens
in the screen printing process) to do nozzle checks.

Important Point!
Before doing your first production run it is important that you do a test
washing for proper cure. Climate can affect cure times while excess humidity can
lengthen cure times and certain garments may require more time. You should
ALWAYS do periodic wash tests as well as test the temperature of your dryer or
heat press using an infrared head gun. Aim the gun at a shirt leaving a conveyor
tunnel and read the final temperature. Infrared heat guns are less than $100 and
available from most screen printing supply companies or industrial suppliers. You
MUST not ignore proper curing.

If using a conveyor dryer, run the belt speed very slow and make sure the garment
lays flat on the belt. If using a heat transfer press, set the pressure to fairly hard. You
should clamp the heat element down directly onto the print with a piece of paper or a
Teflon pad over the print. You can use a baking pan liner for this purpose.

You will probably scorch a shirt doing temperature tests. This is normal in the
garment decorating business.

Some shirts might have a slight discoloration if you use a heat transfer press to cure
the print (reds and medium to dark colors other than black). This discoloration will
usually go away when the shirt cools or when the shirt is washed.
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5. Spots or ink stains must be removed BEFORE
the print is cured using a standard Spot
Removal gun. Make sure to NOT spray the wet
print. Once the ink is cured it is almost
impossible to remove spots or smudges.
Prints can be laundered as normal. If possible,
give the customer washing instructions of: Turn
print inside out before washing or drying,
Cold Water Only, Medium Dryer
Temperature.

You can expect a little fading with the first washing. This is normal and very
similar to what you would get from a screen printed shirt. If you experience a lot
of fading make sure to check your dryer temperature. If the shirts are damp from
excess humidity, you should put them under the heat press for a few seconds to
dry out before printing.

How to use the Print Pass Counter
The Print Pass Counter makes it easier to double print an image when printing on
black shirts. Without the counter you would need to stay by the machine and press
the Load button each time a print pass is completed. With the counter you can set it
for the number of passes and walk away.
When printing light garments you must use a second pass print mode such as
“CMYK Photo 720 2 pass Standard”, in combination with the print pass 
counter.

We have used two different brands of counters on the T-Jet2 printers. Here are the
directions for each.

Gray Keyence Brand
There are two display windows on the face of the
counter. The top display window shows the total
number of passes the printer has made. The bottom
display window shows how many passes you've
selected for that print job.
Press the RST (Reset) button to zero everything out.
Press only the "1" button on the counter until it
indicates the number of passes you need.
You will then need to hit the Load button to start the
job. If you are doing a quantity of shirts with the same design, set the number of
copies you will need in FastRIP. Set the counter to the number of passes you are
doing in the design. Put the first shirt in. Press the Load button. The shirt will
complete itself. Take out the first shirt and put in the next shirt. Press the Load
button again. The next shirt will complete itself. Continue this way until your order is
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finished. You can then hit "Reset" on the counter to zero out the number of passes
(top number) the printer has made.
Note: for this counter only - with a single pass, since you do not need the bed to
reload again, you can leave the counter set at zero.

Black Counter
There are 4 buttons on the counter.
The RST button is for a reset. The counter will reset
whenever you press the Load button or the RST
button. If the counter is Reset the top number will
display“0”.
The bottom number is the number of passes you
want. The up arrow button is for increasing the count
and the down is for decreasing the count.
When you wish to change your counter to a different
setting just press the up arrow or the down arrow button until you get to the total
number of passes needed. To set the count - press the button that has the oval
insignia (the second button from the left).
Note: for this counter only, if you only need 1 pass set the counter at 1 if it is set at 0
the bed will reload.

Things to Watch for
If you trip the laser sensor during printing (by something obstructing the print path)
the counter will become confused. After adjusting the bed height or removing the
object that is tripping the laser sensor, you need to press the Load button which will
reset the counter.
Ignore any out of papererrors you may get when printing multiple “pages.”

Canceling a Print Job
Occasionally a print job will just not print. This could be caused by a problem with
the file, the printer not being in the Load position when the print command is sent, a
red Ink Light flashing showing a color out of ink, or other issues. If you have ever
owned an inkjet printer you know that it is sometimes hard to “kill” a print job.  

Canceling a Print Job - Windows
When you send a print command from your graphics application, the Epson driver
works for a few seconds and then sends the job to Windows Print Manager. It is
almost impossible to stop a print job within the Epson driver if the job is still in
Windows Print Manager.
To open Print Manager, simply double-click on the small printer icon on the lower
right bottom of your computer screen (This section is called the Task Bar). When the
Windows Print Manager opens it shows the status of the print job. A job that is NOT
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printing might still show as printing (print turned off, thinking it is out of ink, etc.).
To cancel a print job simply click on the actual job file and then go to the File pull
down menu and select Cancel All Documents. In some cases it may also be
necessary to power down your computer and printer.

Canceling a Print Job –Macintosh (7 color printing only)
Macintosh OS 9
Open the Print Manager. Click and highlight the job. Click the Trash icon. Close the
Print Manager.

Macintosh OSX
Open the Print Center or Printer Setup Utility. Double click on Stylus Photo 2200 or
SP 2200. Click and highlight the Print job. Click Delete. Close the Print Center or
Printer Setup Utility.

Canceling a Print Job in FastRIP
If there are printing problems when using FastRIP and you have to cancel the print command, right click on
the file and abort the print command. If you get a partial image on a shirt from the previous job, you have not
fully canceled the print command in FastRIP.
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Printing From Various Graphic Programs
Printing from Adobe Photoshop - Design Setup

When designing in PhotoShop, pure white areas will not print an underbase (RGB
255,255,255 or CMYK 0,0,0,0). To print white, set areas to a slight tint off white
(RGB 254,254,254 or CMYK 1,1,1,1). If you want to knock a color out to the shirt
then color the areas as pure white (RGB 255,255,255 or CMYK 1,1,1,1).
The arrows in the following picture identifies that the “N” in California has been set to
RGB 254,254,254, meaning that it will print white.

The arrows in the following example identifies that the background is set to RGB
255,255,255, making the background transparent when printing to FastRIP.
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Note: Color management needs to
be turned off before sending the
image to print. Color Management
is found in the Print with Preview
window. Go to the File menu then
to Print with Preview.

Printing - Adobe Photoshop
Go to the File menu - Print with Preview. Click Page Setup. Click Printer. In the Page
Setup menu select the Fast T-Jet 2 printer. Click Properties. Click Advanced. Set the
Page Size. Go the Printer Features section. Bring the Print Mode menu down to
select the Color Print Mode. Bring the Underbase Mode menu down to select the
Underbase Print Mode. Set the number of ink passes for underbase and color.
Click OK in Advanced Options. In Document Properties set to Landscape or Portrait
for Orientation. Click OK. Click Print.

The Underbase Print Mode to select
will be Image Heavy or Normal
Underbase. Refer to the Print Mode
section for more details on the different
Print Modes.
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Printing from Corel Draw –Design Setup
When designing in Corel Draw, create areas not to print underbase with pure white
(RGB 255,255,255 or CMYK 0,0,0,0). To print white, set the white areas to a slight
tint of off white (RGB 254,254,254 or CMYK 1,1,1,1). If you want to knock a color out
to the shirt then set the color areas as pure white (RGB 255,255,255 or CMYK
0,0,0,0).
In the following example, the selected area is set to CMYK 1,1,1,1, which is
recognized as white areas to print in FastRIP.

Note: When working with vectors solid spot colors, if you use named spot colors and
use the spot color white. FastRIP will create a highlight white when it prints the color
pass. This means that not only will an underbase be applied but on the second pass
(the color pass), white will be printed along with the color. In the example below the
arrow is identifying the use of spot white.
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Solid Spot Colors - No Gradients
Go to File - Print. On the General tab select the Fast T-Jet 2 printer. Click Properties.
Click Advanced. Set the Page Size. Go the Printer Features section. Bring the Print
Mode menu down to select the Color Print Mode. Bring the Underbase Mode menu
down to select the Underbase Print Mode. Set the number of ink passes for
underbase and color. Click OK in Advanced Options. In Document Properties set to
Landscape or Portrait for Orientation. Click OK. Click Print.

Note: Use the Underbase Print Mode to select how the underbase will be printed -
Vector Heavy or Normal Underbase. Refer to the Print Mode section for more
details on the different Print Modes.

Gradients, Gradients with Solid Spot Colors, Bitmap with Vectors
Objects

Go to File - Print. On the General tab select the Fast T-Jet 2 printer. Click
Properties. Click Advanced. Set the Page Size. Go the Printer Features section.
Bring the Print Mode menu down to select the Color Print Mode. Bring the
Underbase Mode menu down to select the Underbase Print Mode. Set the number
of ink passes for underbase and color. Click OK in Advanced Options. In Document
Properties set to Landscape or Portrait for Orientation. Click OK. Click Print.

Note: Use the Underbase Print Mode
to select how the underbase will be
printed - Image Heavy or Normal
Underbase. Refer to the Print Mode
section for more details on the different
Print Modes.
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Printing from Adobe Illustrator –Design Setup
When designing in Adobe Illustrator, create the areas that are not to print underbase
with pure white (RGB 255,255,255 or CMYK 0,0,0,0). To print white, set the white
areas to a slight tint of off white (RGB 254,254,254 or CMYK 1,1,1,1). If you want to
knock a color out to the shirt then color the areas as pure white (RGB 255,255,255
or CMYK 1,1,1,1).
The example below is identifying that the selected home plate is not a pure white
(RGB 254,254,254), meaning that the image will print white.

Note: When working with vectors solid spot colors, if you use named spot colors and
use the spot color white. FastRIP will create a highlight white when it prints the color
pass. This means that not only will an underbase be applied but on the second pass
(the color pass), white will be printed along with the color. In the example below the
arrow is identifying the use of spot white.
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Solid Spot Colors - No Gradients
Go to File - Print. Select the Fast T-Jet 2 printer under Printer menu. Click Setup.
Click and highlight the Fast T-Jet 2 printer. Click Preferences. Click Advanced. Set
the Page Size. Go the Printer Features section. Bring the Print Mode menu down to
select the Color Print Mode. Bring the Underbase Mode menu down to select the
Underbase Print Mode. Set the number of ink passes for underbase and color.
Click OK in Advanced Options. Set to Landscape or Portrait for Orientation. Click
Print in the Print window. Click Print in Illustrator Print window.

Note: Use the Underbase Print Mode to select how the underbase will be printed -
Vector Heavy or Normal Underbase. Refer to the Print Mode section for more
details on the different Print Modes.

Gradients, Gradients with Solid Spot Colors, Bitmap with Vectors
Objects

Go to File - Print. Select the Fast T-Jet
2 printer under Printer menu. Click
Setup. Click and highlight the Fast T-
Jet 2 printer. Click Preferences. Click
Advanced. Set the Page Size. Go the
Printer Features section. Bring the
Print Mode menu down to select the
Color Print Mode. Bring the
Underbase Mode menu down to select
the Underbase Print Mode. Set the
number of ink passes for underbase
and color. Click OK in Advanced
Options. Set to Landscape or Portrait
for Orientation. Click Print in the Print
window. Click Print in Illustrator Print
window.

Note: Use the Underbase Print Mode to select how the underbase will be printed -
Image Heavy or Normal Underbase. Refer to the Print Mode section for more
details on the different Print Modes.
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Production Rates and Ink costs
The following chart shows the average production rates and ink costs you can
expect from your Fast T-Jet. Each image is different and the Print Mode and
resolution you choose will have an effect on these figures. Ink costs might vary from
this chart.
The ink prices are based on the current prices the summer of 2006 and are in US
Dollars.
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Chapter 6
Printing White Ink

White Ink Overview
Printing white ink onto a dark garment was not an easy process to develop because
the openings in the print head are so small thatyou can’t print thick ink likestandard
screen print plastisol. What makes T-Jet2 white ink printing possible is the
combination of a very special ink that took over one year to develop, a software print
driver called FastRIP that allows the printer to print more ink than it was designed
for, a software package called FastARTIST that creates special underbase and
highlight white files, and a revolutionary pretreatment that allows the ink to set on top
of the garment and remain white. It is magic!

Warnings and Cautions
There are a few rules you MUST follow to
get this to work. First, the ink contains white
pigment that can settle over time. The good
news is that your T-Jet2 printer will shake
slightly when it prints causing the ink to
remain in motion. But, if you leave your T -
jet for a few days, you should lift the
individual bulk ink bottles shaking lightly
then run three or four head cleaning cycles. In fact, it is a good idea to do a head
cleaning each morning and two or three times during the day.
You should also get in the habit of lightly shaking the bulk ink bottles every day as
well as the refill bottles before topping off the ink.
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Caution about Pretreatment
The pretreatment is a milky colored liquid that is odorless and nontoxic. It creates a
chemical reaction to the white ink that causes the pigment to stay on top of the
garment. It is CRITICAL that your printing head does not touch a pretreated garment
- even one that has been dried! You should also have good ventilation when using
the pretreatment and if possible pretreat garments in another room.

Important Point!
Yourprinter has a standard “auto reset” chip on each ink cartridge. These chips 
count the number of drops of ink so the printer will tell you when it thinks the
cartridge is empty. In a normal situation you should never run out of ink before the
chip“thinks” you are out because when you turn on and off the printer, it resets the 
chip so it “reads full” again. When printing with white ink it does not take much ink 
usage before the chip tells the printer it is out. If this happens DURING a printing
pass, the printer may stop printing and the red lights one or all of the three white
colors will be ON. If you turn the printer off during a routine you will lose the job and
ruin a shirt. If you need to “reset” the chips during a print run, press the Ink button
and release it. This pauses the routine and moves the carriage over. Unsnap and lift
each cartridge with a red light out of the slot and then press it back in to reseat
cartridge (you will hear a click when properly seated). Even if only one white
cartridge has a red light on, you may want to go ahead and reset all three white
cartridges. Next, press the Ink button as the cartridges are now reset–the printer
will resume printing.

Another option is to turn the printer off and back on between jobs so the chips
always read as full as possible.

Due to the nature of the pigment settling
and the pretreatment reaction, there is a
good chance you will go through more
print heads than normal. If you feel a few
hundred dollars every few months is a
price too steep to pay then we recommend
you do not use the white ink. The payoff of
is vibrant prints on black shirts without any
screen making, press setup, or color
separations that far outweighs the minor
rules to follow.
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Applying Pretreatment
It is essential that the pretreatment be applied in an
even coat as to insure a proper looking print on a black
tee (free from light and dark spots). You can use manual
spray pumps, weed sprayers or other methods for
applying a uniform coating of FastINK Pretreatment but
the best method is to use a Control Spray gun
(commonly used to paint broad areas like a porch deck
or furniture). Your T-Jet2 includes a Wagner Control
Spray gun. If you bought a T-Jet2 out of the USA, your machine may NOT include
the control sprayer. These guns are fairly inexpensive ($70USD at home
improvement stores) and not designed for high volume work. You should keep an
extra gun handy.
Cleaning the gun on a regular basis simply by filling up and operating the gun with
water in the storage bottle. This will keep replacement down to a minimum.
FastBRIGHT pretreatment can be utilized on white/light shirts to make prints stand
out further while FastINK White Pretreatment is used on dark color or light color
garments with a white underbase. Please note that neither product can be mixed
together at anytime. The result will be ruined shirts. If you plan on printing lighter
shirts with a white underbase then make two mixtures of pretreatment. One should
be 100% and the other should be 50% water and 50% pretreatment. The 50/50
mixture is designed for light shirts but will also work on black shirts where bright
white is not necessary.
You MUST NOT spray pretreatment near the printer. In fact, you should
pretreat shirts in a separate room to prevent any sticky overspray from getting
inside the T-Jet2. A simple large cardboard box enclosure is ideal for applying
pretreatment.

Proper Pretreatment Application is Critical!
The two pretreatments (FastBRIGHT and
FastINK White) are magical liquids that keep
the white ink pigments setting on top of the
garment. Do not saturate the garment, move
the spray gun back and forth in even strokes.
You don’t want the shirt to be soaking wet. On 
light shirts only require a misting back and
forth, but black and other dark colors will need
a heavier application. The proper amount
needed is something that you will get the hang
of with repetition. Please note, if you miss a
spot or spit the pretreatment out in uneven spray, it will be noticeable in the final
print.
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Dry the pretreatment using a hair dryer, heat transfer press, or conveyor dryer.
When using a heat transfer press DO NOT use a Teflon sheet or silicone treated
parchment paper to protect the garment when drying the pretreatment. The silicone
in the paper will seal the pretreatment on the shirt surface and the white ink may not
stick well enough.
You can use a Quillon treated baking pan
liner to dry the pretreatment. If the paper
sticks to the pretreatment after you are
done pretreating the shirt, you may have
applied too much pretreatment or the heat
press is set for too much pressure!
Standard “butcher paper” or “brown Kraft 
paper”, can also be used as a heat press 
protector when drying the pretreatment.
Clamp the press down with medium
pressure when drying pretreatment at 330°F
for 8 to 10 seconds.
Important note–As stated earlier, non-diluted pretreatment can leave a stain on
light colored shirts and it is very important to always test shirt color first! It may take
a few tries to find the proper mixture of pretreatment and level of application but that
is all apart of the learning process. Just keep in mind that too much pretreatment
may cause poor washability.

In inkjet printing, the ink will tend to hang onto any loose fibers sticking up from the
shirt. When printing a white underbase it is possible for these fibers to become
saturated and show through the color that has been applied on top. This is why we
recommend the use of a heat press with light pressure as to flatten to fibers properly
before the print. A conveyor dryer or similar method of drying the pretreatment will
not flatten the fibers resulting in a lower quality print.
Some users have reported slightly better washability if you spray the shirt with water
BEFORE spraying it with pretreatment.

Printing White Ink
If the printer has been setting for a few days, perform two or three head cleaning
cycles to get the white ink moving. You should also get in the habit of lightly shaking
the ink bottle to keep the white ink from settling.

1. Setup the file correctly in FastARTIST. Consult the
FastARTIST manual for detailed directions. When
underbasing solid spot color type images, you
generally print solid white ink and then follow that
print with the colors. Underbasing spot color vector
images is as simple as one click of the mouse in
FastARTIST. If the image has white as part of the
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design, a second pass of white is made at the same time as the other colors.
This second pass of white is called a Highlight and it boosts the brightness of the
white.

When printing photorealistic images you will need to run a special routine called the
Underbase Wizard. This special feature of FastARTIST will create a separate piece
of artwork that FastRIP will use to print an underbase of white ink. When
underbasing a photorealistic image, the underbase is NOT solid white but is
grayscale. It has light and dark areas to give the image dimensionality on a shirt.
This is the magic to printing bright and soft prints on dark shirts.
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Important Point! How to Create a Simple Underbase for Dark Shirts.
FastARTIST’s Underbase Wizard has four options to choose from when creating an 
underbase:

 First option - Underbase/Highlight Wizard will manually take you
through the underbase/highlight setup process.

 Second option–Heavy Underbase. This is a one click wonder button
that will automatically complete the underbase process for you.

 Third option–Normal Underbase. This is a one click wonder button
that will automatically complete the underbase process for you.

 Forth option–Last Setting. Performs the underbasing process with the
last used setting from the manual Underbase/Highlight Wizard.

When working with the first option “Underbase/Highlight Wizard”, you must manually
set the parameters for the underbase process. Below we have listed the parameter
settings that will help you get started.

Underbase: white
Underbase strength: 100
Light areas: 80-90
Dark Areas: 5 at the most - but more often 0

NO Clipping Path (if using two versions of artwork).
Check Overlap Highlight
Highlight: white
Strength: 0
Regions: 100 most of the time
(drop to around 80 for bold white text with a black outline)

Light Areas: 0
Dark Areas: 0

For best results when printing gradient images with white ink, you should have two
versions of the artwork to start with. One version has a white background and the
other has a black background. These two files can be created in Photoshop, Adobe
Illustrator, Corel Draw or even in FastARTIST. If you use another program, simply
save or export the files as a JPG file at 150dpi resolution for the final print size.
Import these files into FastARTIST.

There is an excellent video tutorial on Underbasing with Two Versions of the
Artwork on the T-Jet Support page.
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2. You must tell FastRIP what Print Modes to use and choose a Print Mode for both
the white ink and colors. Once you have made the selections, the two can be
used over and over for other jobs. For dark shirts you can get very good “screen 
print” quality white ink if you select the1440dpi Print Mode for the white ink
underbase. For the top colors of Cyan, Magenta, Yellow and Black and the
highlight white, choose 360 or 720dpi Print Modes.
For medium colored shirts use the 720dpi Print Mode (faster than 1440dpi) for
the white ink underbase. In some cases, very light colored shirts may not even
need a white underbase so images can print using just CMYK and highlight white
to save printing time. Highlight white will print at the same time as the color pass.

If possible DO NOT mix print modes. You will notice that certain print modes
contain a ‘HS” and “HS (Bi-Directional)” while the standard print modes contain 
neither. DO NOT use standard print modes in conjunction with HS print modes. The
result may lead to registration issues and miss prints. Please note that this is not
referring to the print resolution i.e. 360, 720, or 1440. Print resolutions can be mixed
and matched as needed. If you are not sure how different print modes work together,
do a test print before doing a production run.

Note: For more information on print modes, refer back to chapter 5 - A Word about
Resolutions, Speed and Quality

Important Point!
Problem with Underbase and Colors lining up.
If you print the 1440dpi HS Print Mode for the white and the colors at 360dpi, there is
a chance you might see white peeking around the colors. This is due to a technique
called Micro-Weave that eliminates banding. It is almost impossible to have the
underbase and top colors line up perfectly in register when mixing Printing Mode
resolutions. For the best results keep the printing resolution either the same, or at
least use 720dpi Print Mode for the colors on top of the 1440dpi white one-pass Print
Mode.
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3. Pretreat the shirt and load it in the printer.
DO NOT let the printing head touch the
pretreated shirt. If the pretreatment comes
in contact with the white ink in the printing
head, the head may become permanently
clogged.
Again, this is really part of the magic and it
may take a few test shirts to get a feel for
how much pretreatment to apply.

4. Set the print pass counter for the number of passes.
When using the 1440dpi Print Mode for white ink
followed by the 720dpi Print Mode for the CMYK
colors and highlight, TWO passes are all that you
will need.

5. Print the job. Send the Print command in FastARTIST. FastRIP will open and
show the progress of the print job.
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Note: If you are not sure how well you
did in creating the underbase, you can
view the actual “Raw Data” in FastRIP 
to see a sample of the different
“Layers” of each print pass. If you
chose the 1440dpi one pass white
print mode you will not be able to
view the raw data.

 Within FastRIP, right click on the
file loaded in the queue and
select Spool Only. After the file
finishes spooling right click on
the file again and select View Raw Data.

6. Cure the print. Carefully remove the shirt from the holder and cure the print. The
white ink will need to be cured longer than standard colors. Cure in a conveyor
dryer or heat transfer press at 330°F for at least three MINUTES.
If using a heat transfer press, place a silicone treated piece of parchment paper
(a common baking pan liner) over the print and close the press with medium to
heavy pressure. When you open the press, peel the paper immediately. The
paper can be used a number of times before it becomes too wrinkled to use.

If you want a glossy print, use a standard Teflon pad rather than silicone treated
parchment when curing the print in a heat press. Teflon pads are available from heat
press manufacturers.
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Washing Directions
For the longest lasting print, the shirt should be turned inside out and washed in
COLD water and dried on the delicate cycle. If possible, include washing directions
with the print.

When you apply the pretreatment correctly and choose the correct Print
Modes you should get very detailed bright prints like these!
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White Ink Troubleshooting
Problem: White prints seem dull.

Solution: You may not be applying enough
pretreatment or not using the 1440 print mode
resolution. But, if you had white prints before
and they now seem dull, you probably have
clogged heads. Due to the nature of the white
pigment, you may experience more head
clogs than normal. These can easily be
cleared by doing two or three head cleanings.

Solution: The Highlight setting in FastARTIST may be wrong and you are actually
printing white ink ON TOP of the CMYK colors–Reload the image into FastARTIST
and redo the Underbase/Highlight Wizard this time either not applying a highlight or
simply toning the highlight down.

Solution: Again, due to the nature of the white pigment, it will build up faster on the
capping station and on the wiper blade. The dry white ink around the rim of the
capping station will cause the print head to NOT seal properly when the printer tries
to pull ink out of the cartridge during a head cleaning cycle. Use a sponge foam tip
swab and water or window cleaner to clean the following areas as shown below.

Print Head

Capping Station &
Wiper Blade
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Also, the small wiping pad on the far side of the printer can get fuzzy and deposit
fuzz on the bottom of the head. Change this pad when it gets covered with excess
ink.

You should perform DAILY
cleaning of these items.

Very Dirty Capping Station!
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Chapter 7
Printing Other Items

Printing on General Items

The T-Jet2 can print on almost any garment type material that can be held in place
or that can lay flat and you don’t need a clamping device. Mouse pads, wood and 
other rigid non-textile items can simply lay on the Garment Holder. The most
important thing is to remember to check the head clearance.
FastINK for your T-Jet2 is a water-based textile ink designed to work on natural
fabric materials. It will also work on non-textile items such as unfinished wood,
mouse pads, golf balls, keyboards, light switch covers and much more with the help
of FastT-Jet Non-Textile Series Pre/Post Treatment. This pre/post non-textile
treatment allows the FastINK to adhere to almost any type of surface.

Smaller items can be placed on smaller Garment
Holders available as accessories for your T-Jet2 or you
can make your own fixtures. Spray adhesive or sticky
table tack can be placed on these special holders to
keep the items from moving. Again, make sure to check
the head clearance with the Height
Adjustment Guide.
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Location Placement
The hardest part of printing on odd size items is determining the print location.
Remember, if you are facing your T-Jet2, the outer right edge is “zero” in your 
graphics program. You can simply make a template or custom page size to match
the size of your shirt holder.

FastARTIST allows you to choose the correct size holder accessories for your
T-Jet2 in the Page Setup window. You must also set the correct “page size” in 
FastRIP setup.

 FastARTIST Page Size–Go to Layout > Page Size
 FastRIP Setup–Go to File > FastRIP Setup
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Adjust Bed Height
For the best prints, the printing surface should set just below the printing head. If the
item has a seam or excess fabric, these areas should set lower than the printing
surface.

Use Spray Glue, Table Tack or Double-Sided Tape to Hold Items in
Place

It may be necessary to design a special cutout from foam core or other thin material
that is the same size as the printing area. You can simply spray glue this to your
normal Garment Holder and use spreadable Table Tack
to hold the item in place. Table Tack stays sticky for dozens and even
hundreds of prints and can be “renewed” by simply wiping it down with a wet rag.

Special double-sided tape available is also available
from us for this purpose.
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Printing Baseball Caps
Baseball caps with and without seams are easy to print on the T-Jet2 using the
optional Baseball Cap Holder. Simply pull the sweatband out of the way, push the
cap against the spring guides, use your finger to press the point in the crown down
around the point on the cap holder, stuff the excess cap under the holder, lower the
clamp and make a print. Some caps require a little more loading technique.
Always be sure to check and double check for head clearance. This will minimize
print head replacement as well as insure better images.
Since a cap may not fit in a conveyor dryer or heat press for ink curing, a simple hair
dryer or industrial heat gun is all you need to cure the final print. You can also simply
remove the holder with the cap in place and lay it under a standard heat transfer
press.
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NON-TEXTILE PRINTING
Required Items

You should have the following in order to print on Non-Textiles.

1. Non-Textile Pretreatment
2. Non-Textile Post-Treatment
3. Fine Bristle Brush

Optional materials may be required.

1. Non-Textile Primer Treatment
2. Holder for object (i.e. Golf Ball Holder)
3. Non-Textile Print Modes (Located on CD or online @

http://screenprinters.net/non-textile_home.php?)

CAUTION: WEAR GLOVES WHEN APPLYING AND USE WITH ADEQUATE
VENTILATION. HANDLE WITH CARE AND PROTECT EYES WITH SAFETY
GLASSES WHEN APPLYING AS A SPRAY. BEFORE USE, CONSULT THE
MATERIAL DATA SAFETY SHEET (MSDS) THAT IS INCLUDED WITH THESE
PRODUCTS OR AT WWW.SCREENPRINTERS.NET
KEEP OUT OF REACH OF CHILDREN

Getting Started
Before printing it will be necessary to determine if the surface intended for printing
will allow the pretreatment to stick. This is due to the fact that certain surfaces will
work with applying the Non-Textile Pretreatment directly while others will require
Non-Textile Primer Treatment first. Generally, smooth surfaces such as light
switches, keyboards, and gloss tiles will require Non-Textile Primer Treatment be
applied before the Non-Textile Pretreatment.

To Test: Apply a very small thin amount of Non-Textile Pretreatment to the intended
printing surface. If the pretreatment does not sick to the surface but instead runs off,
then it will be necessary to use the Non-Textile Primer Treatment.

Important Note: If this is your first time using the Non-Textile Pretreatment, it is
recommended pre-treating small quantities in the beginning to familiarize yourself
with the process.
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Fast T-Jet™ Non-Textile Primer Treatment
Fast T-Jet™ Non-Textile Primer is designed to be used on high gloss
non-porous surfaces as a primer coat prior to the application of our
standard Fast T-Jet™ Brand Non-Textile Pretreatment.

This Primer is designed as an undercoat for our Fast T-Jet™ Brand 
Non-Textile Pretreatment. DO NOT inkjet directly on this product.

DIRECTIONS: Dip the fine bristle brush in the Primer
wiping off any excess on the side of the bottle. Gently
brush Primer over the surface of the non-textile item
making sure there are no uneven areas. Please note
that it is very important that the Primer is applied in a
thin even layer to insure best print quality.

FOR BEST RESULTS: Apply this product with a fine paint brush. After application is
complete, clean brush thoroughly with hot water to remove all Primer Treatment.

This product can be sprayed on, but the application may not be as smooth as
necessary for good print reproduction. If applying with an airbrush, spray bottle or
paint sprayer you may need to dilute solution slightly with water. Apply in smooth,
thin, even layers. Two coats may be necessary.

Clean up spills and brushes with soap and water immediately after use.

Allow primer to thoroughly dry before applying the Non-Textile Pretreatment. Dry
time will vary but can take up to one hour or more. To speed up the drying process
use a hair dryer, heat lamp, or heat gun set on a low temperature setting. Protect
work surface with newspaper.

A heat press can also be used by simply setting the non-textile item under the press
heating element. Be careful to not let the heating element touch the non-textile item.
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Fast T-Jet™ Non-Textile Pretreatment
Fast T-Jet™ Non-Textile Pretreatment is designed for use as an inkjet
ink receptive base coat when printing directly onto non-textile
materials such as plastic, metal, and wood using your standard Fast
T-Jet™ Garment Printer and FastINK™ Textile ink. For increased 
durability of the final print use our Fast T-Jet™ Post-Treatment on top
of the final print. Certain high gloss material may need to be prepared
with our Non-Textile Primer Treatment BEFORE using the
pretreatment. You do NOT need to change inks when using this
product.

DIRECTIONS: If working on smooth, glossy surfaces
where good adhesion is important, apply the Fast T-Jet™ 
Non-Textile PRIMER before using this product. Primer
Treatment must be thoroughly dry before applying this
pretreatment.

Dip the fine bristle brush in the pretreatment wiping off any excess on the side of the
bottle. Gently brush pretreatment over the surface of the non-textile item making
sure there are no uneven areas. If Primer was applied, then Primer treated surface
must be covered with pretreatment. Please note that it is very important that the
pretreatment is applied in a thin even layer to insure best print quality.

FOR BEST RESULTS: apply this product with a fine paint brush. After application is
complete, clean brush thoroughly with hot water to remove all pretreatment.

This product can be sprayed on but the application may not be as smooth as
necessary for good print reproduction. If applying with an airbrush, spray bottle or
paint sprayer you may need to dilute solution slightly with water. Apply in smooth,
thin, even layers. Two coats may be necessary.

Clean up spills and brushes with soap and water immediately after use.

Allow pretreatment to thoroughly dry before inkjet printing on it. Dry time will vary but
can take up to one hour or more. To speed up the drying process use a hair dryer,
heat lamp, or heat gun set on a low temperature setting. Protect work surface with
newspaper.

A heat press can also be used by simply setting the non-textile item under the press
heating element. Be careful to not let the heating element touch the non-textile item.
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Since the pretreatment process can take some time to dry, it is recommended that
you pre-treat as much of the production run as possible to avoid delays due to drying
time (Do this only after becoming proficient with the Non-Textile
Primer/Pretreatment).

Setting up an Image for Print
To setup an image for print, you must use a graphic application such as
FastARTIST, Photoshop, or CorelDraw. Anyone of the three applications are
capable of printing to FastRIP, but for this manual we are going to setup the image
using FastARTIST. The steps in the other graphic applications will be very similar;
please consult your applications owner’s manual if needed.

1. Setup the printing area in which you will be printing on. To
do this you will need a measuring tape and will need to
measure the width and height of the Non-Textile item. Now
in FastARTIST select File > FastRIP Setup.

2. From the Setup window, select
Page Setup Tab. In the Page Setup
Tab select Custom under the page
option. Now enter the height/width
of the Non-textile item you
measured. When you are done
entering in the values click OK to
return to back to the workspace.
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3. Next select Layout > Page Size. In the
Page Size enter the height/width of the
Non-textile item you measured. When you
are done entering in the values click OK to
return to back to the workspace. The non-
textile item dimensions will now be
represented by a black box located within
the workspace. If this is not displayed click
View > Show Page Size to view black box.

4. Import your image for print, positioning the image as you would on the non-textile
item. For further FastARTIST help, please reference the user manual.

5. Once you are done setting up in FastARTIST, Photoshop, or Corel, you will need
to print to FastRIP.

Printing to FastRIP - FastARTIST Click File > Print to FastRIP > Position
the image then click the printer icon located in the printer tool box to
complete sending the image to FastRIP.

Printing to FastRIP - Adobe Photoshop

Go to the File menu - Print with Preview. Click Page Setup. Click Printer.
In the Page Setup menu select the Fast T-Jet 2 printer. Click Properties.
Click Advanced. Set the Page Size. Go the Printer Features section. Bring
the Print Mode menu down to select the Color Print Mode. Bring the
Underbase Mode menu down to select the Underbase Print Mode. Set
the number of ink passes for underbase and color. Click OK in Advanced
Options. In Document Properties set to Landscape or Portrait for
Orientation. Click OK. Click Print.

Printing to FastRIP–CorelDraw

Go to File - Print. On the General tab select the Fast T-Jet 2 printer. Click
Properties. Click Advanced. Set the Page Size. Go the Printer Features
section. Bring the Print Mode menu down to select the Color Print Mode.
Bring the Underbase Mode menu down to select the Underbase Print
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Mode. Set the number of ink passes for underbase and color. Click OK in
Advanced Options. In Document Properties set to Landscape or Portrait
for Orientation. Click OK. Click Print.

Printing Multiple Items on the Print Bed
When printing multiple items on the print bed at the same time you must configure
the FastARTIST or graphic application so that each individual image is applied in the
proper location.

1. The total print area must first be set to incorporate all the items on the print bed.
Measure the total length and height of all the items on the print bed.

2. From the FastRIP Setup window, select
Page Setup Tab. In the Page Setup Tab
select Custom under the page option. Now
enter the height/width of the Non-textile
items you measured. When you are done
entering in the values click OK to return to
back to the workspace.
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3. Next select Layout > Page Size. In the Page
Size enter the height/width of the Non-textile
items you measured. When you are done
entering in the values click OK to return to
back to the workspace. The non-textile items
collective dimensions will now be
represented by a black box located within the
workspace. If this is not displayed click View
> Show Page Size to view black box.

Now that the total print area has been set, you must now determine the location that
each individual image is to be applied.

1. On the first non-textile item that is
closest to the upper left hand corner
of the print bed, measure from the left
side of the print bed to the center
point where the image is to be
located (X axis). 1 ¼” - 1.25”

Logo

Upper Left-
hand Corner

Upper Left-hand
Corner
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2. Next using the same item, measure
from the top of the print bed down to
the bottom point where the image
should stop on the non-textile item (Y
axis). The red doted line identifies the
measurement taken for the bottom of
the logo. 1 7/8” – 1.88”

3. Steps 1 and 2 will give you the location in which to position the first image. Using
the rulers positioned around the FastARTIST workspace place the image in the
desired location or with the image selected on the workspace, you can type in the
desired location in the x/y boxes.

4. Repeat steps 1, 2, and 3 for remaining items in the print bed. For you
convenience, we suggest measuring the items starting in the upper left hand
corner then moving left to right from top to bottom.

Setting up FastRIP
Once an image is printed to FastRIP,
FastRIP will open and proceed to spool the
print job.

1. Double click on the file in the Queue
window.

2. This will now bring up the Job Ticket
Properties window. Under the General
Tab select the Max Ink Tab. Check
the Overwrite Print Mode Max Ink
Data box and change the Max Ink
Level from 400 to 300, click OK.

L
o
g
o

Upper Left-hand
Corner
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Positioning for Printing
1. Set the item in the upper left-hand corner

of the print bed without a shirt board
loaded in. Raise the bed and use the
height adjustment bar to make sure it is at
the right height. (See T-Jet manual for
more details). For odd shaped items,
create a holder or fixture to hold the items
in place during printing. Print using the
standard Photo Print Mode settings for white T-Shirts. Sample prints may be
necessary to determine the correct Print Mode settings.

2. If all the previous setup instructions have been completed above, within
FastRIP - right-click on the job and select Print.

Fast T-JET™ Brand Non-Textile Post-Treatment
Fast T-JET™ Brand Non-Textile Post-Treatment is a protective coating
used for printing on non-textile surfaces to achieve a long life to your
prints while waterproofing and preventing the ink colors from fading as
well as acting as a UV protectant. Use this product with our other non-
textile treatments such as Fast T-JET™ Brand Non-Textile
Pretreatment.

DIRECTIONS FOR USE: Shake can before
each use. Spray onto non-textile, printed
surfaces after drying has been completed. Apply
a thin coat, 4 to 8 inches from surface. Use a
swift motion to prevent over spray and
unwanted buildup. If build up occurs, use
lacquer thinner to reduce. A second coat may
be applied after approximately two minutes of
dry time. Let surface dry for 30 minutes to one
hour. Let dry in a clean, dust free area to
prevent debris from sticking to the surface.
Clean valve after use. Turn can upside down and spray a short burst until cleared. If
nozzle is clogged or sprays irregularly, check for coating in opening. Scrape off with
soft object and twist valve one half turn. Allow 24 hours cure time prior to placing
coated graphics into service.

Upper Left-hand
Corner
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Printing Golf Balls
Before printing golf balls you must first install special print modes designed
specifically for printing small prints found on items such as golf balls.

Installing GOLF BALL Print Modes;

1. Locate the FastJet2.pmz file within the Non-Textile Print Modes Folder on the
Non-Textile Printing CD or download from the following web address:
http://screenprinters.net/non-textile_home.php?

a. When downloading the print modes, open the downloaded zip file and
save to your desktop.

b. Double click on the zip file on your desktop, then drag and drop
FastJet2.pmz file onto the desktop.

2. After locating the FastJet2.pmz file open FastRIP.

3. From FastRIP select Printers > Manage Print
Modes.

4. Use the drop down menu and select fast T-Jet2.
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5. A list of print modes now be displayed and
the icons located at the top of the window
will become available.

6. Select import print mode package identified below.

7. Locate the CD folder Non-Textile Print Modes to access the FastTjet2.pmz file
(or on the desktop if downloaded) and click Open.
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8. A list of four print modes should appear below, Select all, and then select import.

9. There will be a new folder called Non-Textile Print Modes in the Print Mode
Manager Window. Expand the folders contents by clicking on the black triangle to
the left of the folder. Place a check in the box to the left of the folder and for all
the proceeding print modes.
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10.Select Import Selected Print Modes to Control Panel which has the icon of a
blue clip board with a red check on it.

11.Close the window and you now have Non-Textile
1440 print modes for golf balls.

Pre-Treating the Golf Balls
For printing golf balls you will need to use optional Golf
Ball Holder, Fast T-Jet™ Non-Textile Pretreatment, and
Fast T-JET™ Brand Non-Textile Post-Treatment. Fast
T-Jet™ Non-Textile Primer is not necessary for golf ball
printing as the balls surface works perfectly with just
the pretreatment.

1. Load the Golf Balls in to the holder and place the guard on top of the balls. The
guard will protect the area not being Pre-Treated as well as any overspray from
printing.

2. Dip the fine bristle brush in the pretreatment
wiping off any excess on the side of the bottle.
Gently brush pretreatment over the exposed golf
ball surface making sure there are no uneven
areas.

3. Allow pretreatment to thoroughly dry before inkjet printing on it. Dry time will vary
but can take up to one hour or more. To speed up the drying process use a hair
dryer, heat lamp, or heat gun set on a low temperature setting.
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Loading Golf Ball Template (FastARTIST Only)
1. Go to File > Open and double click on the Golf Ball Holder Template to open

template.

2. Import the images or text you wish to print and place them inside of the lines.

3. Choose one of the following print modes:
Non-Textile Photo 1440 Standard
Non-Textile Photo 1440 Standard HS
Non-Textile Cartoon 1440 Standard
Non-Textile Cartoon 1440 Standard HS

4. Print to FastRIP.

Golf Ball Holder Placement
Position the Golf Ball Holder in the top-left corner of the
print bed without a shirt board loaded in. Holder will be
positioned from left to right within the print bed. Raise
the bed and use the height adjustment bar to make
sure it is at the right height (see T-Jet manual for more
details).

 If all the previous setup instructions have been completed above, within
FastRIP - right-click on the job and select Print.

Upper Left-hand
Corner
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Finish with Fast T-JET™ Brand Non-Textile Post-Treatment

DIRECTIONS FOR USE: Shake can before each use. Spray onto non-textile,
printed surfaces after drying has been completed. Apply a thin coat, 4 to 8 inches
from surface. Use a swift motion to prevent over spray and unwanted buildup. If
build up occurs, use lacquer thinner to reduce. A second coat may be applied after
approximately two minutes of dry time. Let surface dry for 30 minutes to one hour.
Let dry in a clean, dust free area to prevent debris from sticking to the surface.

Non-Textile Printing Tips
 When brushing on any of the treatments make sure it is placed on smoothly and

evenly in thin layers.
 Having two brushes can make the job easier one for the Non-Textile Primer

Treatment and one for the Non-Textile Pretreatment.
 Cleaning the brushes when done with hot water and letting dry will prevent them

from drying out and ruining the brushes.
 When printing on the Non-Textile items use a piece of film that covers the whole

item and print on the film to see if it aligns and prints right.
 The Print Bed area is 13” X 18” on a T-JET Standard and 13” x 22” on a 

T-JET 2. To maximize production you can line up multiple items next to each
other and print more then one at a time.

 If you have a heat press in which you can place the items under, do so without
making contact to dry the Non-textile items faster.
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Chapter 8
Simple Maintenance and

Utilities to Improve Print Quality
There are a number of simple Maintenance procedures that will have to be
performed periodically requiring the use of the Epson Printer Driver Maintenance
Utility. The following procedures are necessary to maintain a high print quality and
to avoid reoccurring problems.
One specific problem that can occur during printing is lines missing in the printed
image called banding. The two most common reasons for banding is a dirty or
clogged printing head, or a head that is misaligned.
If your prints are unexpectedly light, or dots or lines are missing, you may need to
clean the print head. This unclogs the nozzles so they can deliver ink properly.
Print head cleaning uses a lot of ink, but we recommend doing at least one
cleaning cycle each day. Print head cleaning may be necessary if you let one of
the ink bottles on the bulk ink system run dry or if your printer has been setting for
a few days without use.
To clean the print head simply hold down the Ink button on the T-Jet2 Control
Panel for three seconds or use the Epson Maintenance Software for more
advanced options with regards to Head Cleaning and Nozzle Checks.
When your T-Jet is not in use make sure that the power is off so that the print head
docks on the capping station to avoid drying up and clogging. Then when the
printer is powered back on the T-Jet will then proceed with its normal start up
cycle.

Running the Head Cleaning Utilities
1. Make sure your printer is ON but not printing and

all of the red ink lights are off.

2. Windows: Right-click the printer icon on the
bottom right hand corner of your screen (Task Bar)
and select Head Cleaning. If there is no printer
icon, go through the normal steps to print from an
application and when at the Epson Menu, select
the Maintenance tab.
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MacintoshOS 8.6to 9.x: Choose File> Page Setup or
Print. Click the utility button, then click the Head
Cleaning button.
MacintoshOS X: Open the Applications/Utilities.
Select Printer Setup Utility or Print Center. Click and
Highlight SP 2200 or Stylus Photo 2200. Click on Utility
button. Select Head Cleaning.

3. Follow the on-screen instructions. Cleaning
will take about 45 seconds during which time
the printer makes noise and the green Power
light and the red Ink lights will flash.
You should never turn off the printer while
the power light is flashing, this may damage
the printer. You can do head cleanings at
any time even when the printer is printing. It
will stop and clean the heads and resume
right where it left off. Since the Head
Cleaning cycle also wipes the bottom of the
head, it is recommend to do head
cleanings if you start to see drops of ink on
garments or if the head comes in contact
with a garment.

4. When both the power light and the ink
lights stop flashing perform a Nozzle
Check. You will need a few sheets of letter
size paper OR clear inkjet film for this
purpose. It is hard to see the white ink on
white paper when doing a nozzle check so
the film is a better choice.
Lay the paper or film on the top of the
Garment Holder butting up against the zero
point of the bed.
Next, click Print Nozzle Check Pattern in
the Head Cleaning dialog box and follow
the on-screen prompts.
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5. After the Nozzle Check Pattern has printed out check to see if the lines have any
gaps or lines in them. If the Nozzle Check Pattern has no gaps or lines click
Finish.

If the Nozzle Check Pattern does have gaps and lines click the Clean button to
clean the heads again.

For serious clogs you can run this routine DOZENS of times. Doing this will use
a lot of ink but will generally eventually clear badly cloged heads. You can also turn
off the printer and place a few drops of glass cleaner or cleaning fluid on the capping
station pad and wait overnight to let the ink soften and try doing head cleanings
again the next day.

Aligning the Print Head
The print head can become out of alignment through normal use, during shipping,
or if the print headhits or “crashes” into a garment or the metal holding ring. The
following procedure shows how to do basic print head alignment. If the head has
had a hard crash into a solid surface, it may be permanently damaged or
permanently out of alignment and will need to be replaced.
If your prints contain vertical or misaligned lines, or you see banding of any kind, you
may need to align the print head.
1. Turn the printer ON

2. Lay letter-size paper (8.5 X 11) or clear inkjet film on top of the Garment Holder
the same as for the Nozzle Check. If the paper curls it may be necessary to
tape it in place.

3. Windows: Right click on the printer icon (bottom right hand corner of your
taskbar) and select Print Head Alignment. If the printer icon is not showing,
open your graphic application and go through the print routine. When you are at
the Epson Driver menu, select the Maintenance tab and Print Head Alignment.
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Macintoshes 8.6or 9.x: Choose File>Page Setup or Print. Click the utility button,
and then click the Print Head Alignment button.
Macintoshes X: Open the Applications/Utilities. Select Printer Setup Utility or Print
Center. Click and highlight SP 2200 or Stylus Photo 2200. Click on Utility button.
Select Print HeadAlignment.

4. Follow the steps on the next screen to
print the next test page.

5. Once the test page has printed out
choose the set with the least banding
between the two lines.

If rows #1 and #2 line up the best on number 8 click
Next and continue to step 7.

 If rows #1 and #2 do not line correct on
number 8 continue to step 6.

6. Select the pattern from each row # 1 and 2 that
lines up the best and enter the number in the
Print Head Alignment window where prompted.
Click Realignment. Continue this step until
rows #1 and #2 lines are correctly aligned on
number 8. Click Next.

7. Reload printer with new sheet of paper of clear film and click next to print second
test pattern.

8. Repeat steps 5 - 7 until you have a third test pattern.
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In the third test pattern, if box 3 is the least grainy in all the rows click Finish. If box 3
is the best one in one or two rows, but you still need to adjust other rows, clear the
checkbox(s) for the good rows and click on Realignment. This will print out another
test page for the rows that were left checked.

Emptying the External Waste Bottle
As your T-Jet2 goes through head
cleaning cycles it forces ink through the
print head. This excess ink goes into
the External Waste Bottle located at the
back of the T-Jet2 on the control panel
side.
To empty the waste bottle simply
unscrew the top of the
bottle and remove, carefully placing the
waste bottle top with waste ink
line attached on a rag or old t-
shirt. Empty waste bottle and
replace waste bottle top.

In the rare instance that your printer thinks that you have used enough ink to fill the
entire Waste Bottle, all of the ink lights will blink without an obvious way to reset the
counters. This can happen if you have printed anywhere from 10,000 to 15,000
pages. At this point you are not able to run the printer until you re-set the Ink
Counter in the printer. Please see the following section.
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Resetting Ink Counter
If you need to reset the ink counter, please visit http://support.equipmentzone.com
There are two ways to reset the counter. The hardest way
is to remove the covers from the machine and press a few internal buttons. There is
also an easy “softwaresolution”that can be used. Our friendly support staff will
gladly walk you through the steps.

Print Head Replacement
In the event that you damage the
printing head by hitting it against the
metal holding ring, the head will
probably need to be replaced. If you
can’t get the headto print in alignment
after numerous alignment routines
there may be permanently damaged.
Replacing the head is actually not too
difficult and will take less than 30
minutes. Replacement heads are
readily available
and come with complete written and DVD
replacement instructions.
If you are dependent on your T-Jet2 and cannot afford to be down for a few days we
recommend keeping a replacement head in stock.
There is a short video online at T-Jet Support on how to replace the print head.
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Chapter 9
Preventative Maintenance

and Problem Solving
Your T-Jet should work trouble free if you take time to understand and perform the
necessary machine maintenance. 95% of our technical support calls come from
people who have not maintained their machines properly. While the T-Jet’smay
appear to be just an inkjet printer, it is a VERY SPECIAL inkjet printer. When
printing onto garments, the printer must print A LOT more ink than when printing on
paper. This can and will cause excess ink to get on internal parts if the machine is
not maintained on a regular basis.
When printing dark shirts with white ink, the pretreatment is sticky and if sprayed
near a machine can get on the internal working parts of the printer. Inkjet printers
in general do not like hot dry room conditions or to be in a dusty, dirty shop. You
have made an expensive investment and in order to get the most out of it, please
take time to learn about the simple steps that will keep your T-Jet happy and
making money.

Keep your Encoder Strip Clean
One of the main support issues is the printer
getting confused on how to print an image. The
magic that tells an inkjet printer printing head
where to print is a thin strip called the Encoder
Strip. A dirty encoder strip can cause everything
from images printing in the wrong location, large
blocks of ink spraying on the shirt, double-
images, dark bands across the print, thin
horizontal lines and much more. The printer
head reads this clear strip (containing
data) when the head is moving. If the strip
gets dirty with lint from shirts, or ink over
spray it can confuse the printer. Please
do daily and weekly maintenance on the
unit as required in this chapter.
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Daily - Clean the Encoder Strip

1. Turn the Printer off and unplugged the
Power cord. Make sure that the Print Head
is parked in Home position (over the
capping station).

2. You can use foam tipped swabs but for best
results use Alcohol Pads that are Isopropyl
Alcohol. Do NOT use Rubbing Alcohol
pads. Wrap the Alcohol Pad around both
sides of the Encoder strip. Move the Pad in
both directions. If the pad becomes black
then use a new pad and clean the Encoder strip again. Now move the Print Head
from Home position. Clean this section.

3. Let the Encoder strip AIR DRY.

Weekly - Clean the Encoder Strip by Removing from the Printer

1. Turn the Printer off and unplugged the Power cord.

2. Remove the side panel on the opposite side from the
Control Panel (Power/Ink buttons).

3. With Needle Nose pliers gently unhook the metal
spring tensioner from the metal bracket. This is on the
opposite side from the Control Panel.

4. Move the print carriage (away from the control panel)
towards the center of the print bed and unhook the
Encoder Strip from the metal hook securing the
Encoder Strip.

5. Pull the Encoder strip out from behind the carriage.

6. Rotate the Encoder strip 90 degrees up and Gently Pull the Encoder strip off the
hook located to the right of the spring tensioner (opposite the control panel side).

7. Use Alcohol Pads that are Isopropyl Alcohol. Do NOT
use Rubbing Alcohol pads. Rap the Alcohol Pad
around both sides of the Encoder strip. If the pad gets
black then use a new pad and clean the Encoder strip
again.



Chapter 9–Preventative Maintenance and Problem Solving

115

8. Let the Encoder strip AIR DRY.

9. Take Pipe Cleaner and run it through the sensor
reader slot on the back side of the carriage. This is
the slot the Encoder strip runs through.

Do NOT remove the print head
carriage from the printer to clean the
encoder sensor on the back. The two
photos on the right show the carriage
off of the printer so you can see the
sensor better.

10. Reposition the Encoder Strip in the proper
direction with the T-Jet (Spring on the
opposite side of the control panel).

11. Place the Encoder strip at the 90 degree
angle then twist the Encoder strip back a
horizontal position to the printer.

12. Slide the Encoder strip through the reader slot on the back side of the carriage.

13. Hook the Encoder strip on the metal hook on the side with the Power\Ink
buttons.

14. Hook the spring tensioner back on the metal hook (opposite side from the
control panel).

15. Slide the carriage back and forth. Look for binding or twisting of the Encoder
strip.

There are two helpful videos on cleaning the encoder strip on our T-Jet
support page at screenprinters.net/supporttjet.php.

Note: The Encoder Strip is actually CLEAR with small marks on it. Be careful
to NOT scratch it or the sensor will not read it correctly. Only use FOAM TIP
cleaning swabs when doing any maintenance or cleaning inside your T-Jet.
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Turn your T-Jet OFF at night
Turn OFF the machine at night using the Power Button only. This will ensure that the
print head is properly seated on the capping station. DO NOT use a power strip to
turn off your printer.

Don’t top off the bulk ink bottles
When refilling the bulk ink bottles STOP at the FULL LINE marked on the side of the
bottle. This will prevent excess pressure which can cause ink to drip out of the
bottom of the print head.

Clean Capping Station and Wiper Daily
The capping station is the rectangular piece that the inkjet
printer head seats onto. There is a sponge in the capping
station and a wiper (small squeegee) next to it. Make sure
both are free of dried ink and garment fibers. Use a foam
swab and distilled water, glass cleaner or isopropyl alcohol to
keep this clean.

The pictures on the right show two very dirty capping
stations. The capping station seals the print head
when it is not in use. Ink residue around the edge of
the capping station keeps the
head from seating and sealing
properly which can cause head
clogs. White ink will buildup a
little more than normal colors.

EJECT LOAD INK ERROR
EJECT

POWER
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Note: When cleaning the capping station, be careful to NOT dislodge it out of
position or the print head will not seat properly. If you push down on it too hard it will
move off of the mount.
For better cleaning you can remove the entire capping station assembly.

Removing the Capping Station
1. Remove the side panel from the control panel side. The side panel contains 5

silver screws holding the panel on, four are located on the bottom of the panel
and the fifth is on the back side of the T-Jet2. When all the screws are removed,
remove the panel.

Note: There is a counter that is attached to the panel, so be careful not to pull out
the panel too far from the T-Jet2.

2. Remove the square panel that is blocking the access to the capping station.
There are two screws holding this in place. As show below.

3. Remove the screws as identified
on the right that are currently
securing the capping station/pump
assembly in place.
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4. Both capping station/pump assembly can now be removed and to do so, there
are two different methods in which you can follow–Removal from the top or
removal from the side.

Top Removal Step
 Pull the capping/pump assembly out the side then tilt upwards. This will allow

for easy removal from the top.

Side Removal Step
 The capping/assembly station will need to be turned to the side in order to

comfortably remove with out damaging the clear plastic pump hose.
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5. Next, remove the capping station assembly from the silver plate that holds the
pump assembly. Start by moving the wiper blade as far to the right as possible
then simply disconnect the capping station.

6. Remove the black line with the white coupler from the clear pump assembly ink
tube.
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7. Make sure that the arm for the pumping station is properly attached to the wiper
blade assembly. If the arm is not attached during a head cleaning, the pump
assembly will make a grinding sound. Using a small flat head screw driver or
pen, simply move the arm back into the grove on the wiper blade assembly.

8. Next look at the capping station to make sure
that nothing is blocking the ink from flowing
through the black hose into the clear one. A
way to test this is to pour some cleaning
solution into the top of the capping station and
see if it comes out of the black hose
underneath.

9. Next, take a foam swab and clean the rubber seal with cleaning solution and
wash the capping station in hot water to remove all of the ink build up.

10.Flush the pumping station simply by
inserting a syringe with cleaning solution into
the clear pump assembly tube where the
white coupler was removed. Push the
cleaning solution through the pump.

11. Clean the wiper with a foam swab.
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Reinstalling the Capping Station

1. Make sure you have all
the pieces shown
below: one pump
assembly, one cap
assembly, one rubber
wiper blade, and one
cloth wiper blade.

2. First install the wiper
blades as shown in the
picture on the right.
Position the rubber blade
behind the cloth one so
that the curve on the
rubber faces away form
the gear. The cloth is
closest to the gear.

3. Use a small flat head screw driver to help mount the wiper blades onto the
capping station. Make sure that the two openings at the bottom of the wiper
blades fits securely over the two plastic grommets.
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4. Now that the wiper blades are in place, connect the cap assembly to the pump
assembly. Do this by connecting the black hose to the white coupler and then the
white coupler to the clear hose with the green line coming out of the side of the
pump assembly.

5. Make sure that the arm for the pumping station is properly attached to the wiper
blade assembly. If the arm is not attached during a head cleaning, the pump
assembly will make a grinding sound. Using a small flat head screw driver or
pen, simply move the arm back into the grove on the wiper blade assembly.

Capping Station
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6. Once the wiper blade arm is in place,
finish installing the cap assembly. There
are two holes located on the silver plate
that the capping assembly fits into. Move
the wiper blade assembly all the way to
the right for this step. When positioning
the capping assembly in the silver plate,
make sure that the white pin from the
wiper blade assembly fits within the
capping assembly as shown.

7. Once the assembly is put back together, place it back in the machine. This is
done by turning the assembly sideway to fit in the opening as show below. Make
sure that the hose does not get caught on the side of the machine.

8. Position the capping/pump assembly carefully
back into the machine and secure the silver
plate with two screws. Check the top view to
make sure everything is in place as shown on
the right.
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9. The final step is to put the screws back into the Capping/Pump assembly. Please
note that the Capping assembly is on the outside of the machine when screwing
it back in, as shown below.

10. Replace square cover and chrome panel at this time.

Humidity and Environmental Control is a MUST
During the cold winter months dry heat is often pumped into the
room. Inkjet printers like humidity levels of 35% to 80%. If your
room is dry, place a humidifier in the room and buy an
inexpensive hygrometer from Radio Shack to measure the
humidity level. In the summer months if the humidity is too high,
use a dehumidifier. Try very hard to NOT place this machine in
a dusty, dirty or non-controlled environment (like a screen
printing shop). For best results, place the T-Jet in a dust free
room with air-conditioning control.
Important Note: Do not allow fans to blow air across the print heads as they could
dry up and clog, seriously effecting T-Jet performance.
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Print with lid closed
Due to the airborne nature of the white ink pretreatment, you should try to pretreat
shirts in a different room or far away from the machine. If pretreating in a different
room is not an option, then make sure that the lid on the T-Jet is kept closed at all
times and especially during the print process. The pretreatment will immediately clog
the print heads if put into direct contact. We strongly suggest making an enclosed
area to pretreat the shirts such as a large box or something of that nature to keep
overspray down to a minimum. This is to not only protect the print heads but insures
that the encoder remains clean as well.

Some users feel they have fewer problems with a dirty encoder strip if the lid
is left open; this is possible as long as pretreatment is not sprayed near that
machine.

Preparing your T-Jet for Down Time
In the event that your T-Jet2 is going to sit for more than 3 days without use, it will
be necessary to prep the machine for the down time. The preparation process
should only take about 10 minutes and if you have any questions regarding any of
the steps, please call our support department during regular business hours as
follows:

Toll Free +1 888-MYTJETS (698-5387)
Technical Support +1 480-929-2937
Email: support@usscreen.com.
Support hours: 7:00am to 8:00pm Monday through Friday

9:00am to 3:00pm Saturday
(Mountain Standard Time) USA

Note: Arizona does not observe “Daylight Savings” in the US.
In the summer months, Arizona is on the same time as California.

Installing the T-Jet2 Cleaning System

The first step of the preparation process will be to install the refillable cleaning
cartridges as follows.

1. Remove ink line from ink cartridges and cap
the end of each ink line with a red ink line cap.
Be sure to remove and cap each line
individually to avoid ink siphoning out onto the
cartridges.
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2. Using the white ink cartridge caps, now cap each bulk
system ink cartridge as shown.

3. At this time you can remove the ink cartridges simply
by pushing cartridge tabs inward as shown in the
example on the right. This will then release the ink
cartridge from the print carriage.

Important note about storage of ink cartridges: When the ink cartridges are
removed make sure to place them upside down as this will prevent ink from leaking
out. We also recommend that the bottom of the ink cartridge be taped and placed in
an individual plastic zip lock bag.

4. Tie loose ink lines to cable chain with zip tie. This will keep the ink lines from
moving around and possibly damaging the encoder strip when performing the
necessary head cleanings. Make sure to allow for a natural bend in the ink line;
DO NOT kink the ink lines.
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5. Install the Refillable Cleaning Cartridges
and perform 3 to 4 head cleanings. When
performing a head cleaning with the
cleaning cartridges the bottom rubber plug
must be removed.

If the rubber plug is not
removed during a head
cleaning–damage can be
caused to the print head.

IMPORTANT NOTE: DO NOT RUN A NOZZLE CHECK WITH CLEANING
CARTRIDGES. Cleaning solution will leak out into T-Jet causing serious
damage.

To purchase Refillable Cleaning Cartridges contact:
Equipment Zone Sales:
Monday - Friday 8:30a.m. -6:00 p.m. (EST)
Main Line and Sales (201) 797-1504
Toll Free Order Line 1 (800) 408-0040
sales@equipmentzone.com

1 2 3
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6. Place rubber plugs back into the bottom of the
refillable ink cartridges.

7. Turn the printer OFF by pressing the Power button only. As the printer powers
down the print carriage will move onto the docking station. The docking station is
located on the control panel side of the printer.

8. Close the Waste Bottle Valve - Anytime that
the T-Jet2 is powered off make sure to close the
waste bottle valve to prevent cleaning solution
from siphoning through the capping station.

The preparation process is now complete and the T-Jet2 should now be
covered for the duration of the down time.

Eliminating Ink Drops on Shirts
When you perform a head cleaning, the head itself is cleaned
and wiped by the printer. On occasion, this may not clean away
small pieces of shirt lint that collect around the bottom of the
head. This excess lint can create an Ink build up under the
print head causing ink to drip on the garment. The easiest way
to see this debris is to remove the shirtboard and shine a
flashlight onto the chrome base of the print bed looking into
the reflection to view the print head as shown below. Clean
any lint and ink residue off with a Foam tip swap and cleaning
fluid or glass cleaner. BE CAREFUL to not rub the bottom of
the head too hard where the actual nozzles are located.

EJECT LOAD INK ERROR
EJECT

POWER
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External Fuse
As of August 1, 2006, all T-Jets are shipped with an external fuse on the rear of the
machine. If there is a short involving the ribbon cables connection between either the
print head or the mother board the fuse will blow. A blown fuse can easily be
identified by the printer head moving without dispensing ink. The T-Jet ships with a
second (600ma) fuse, but before replacing, contact technical support to solve the
problem that caused the first fuse to fault. Otherwise you will have two blown fuses.

For powerful head cleaning use the Epson Utility and not the ink
button

Holding down the Ink button on the T-Jet control panel for
three seconds with perform a head cleaning, but the
Epson Head Cleaning Utility is much better. If a Cleaning
and Nozzle check is executed multiple times, each
additional cleaning is more powerful than the previous. To
get the benefit of the more powerful cleaning, you MUST
alternate between Head Cleaning and then Nozzle
Checks within the Epson Utility.
You can perform up to FOUR nozzle checks/head
cleaning cycles in a row as the strength of each will increase.

IMPORTANT NOTE: DO NOT RUN A NOZZLE CHECK WITH CLEANING
CARTRIDGES. Cleaning solution will leak out into T-Jet causing serious
damage.

Ink Hose Clip
Between early December 2005 and mid-
January 2006, we shipped T-Jet2 printers
with a metal ink tube clip that only used
double-stick tape to hold the tubes in place.
This is no longer a supported item as you will
need to upgrade to the new cable chain
system if applicable.
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Clean Bulk System computer chips
The small computer chips on the back of the ink cartridge can get dirty and not make
good contact. If you get erratic red lights on certain colors, clean the chips with a
foam tipped swab and isopropyl alcohol. A pencil eraser works for this as well.

Have a lot of RAM for your computer
RAM is the temporary memory that your computer uses when processing complex
data. Ram is NOT expensive. Most computers ship with 256mb of RAM. This is
not enough, especially when using FastARTIST and FastRIP. Your computer should
have a minimum of 512mb and preferably 1 to 2 GB of RAM.

When in doubt–unplug everything
Sometimes inkjet printers get confused especially if you stop them in the middle of a
print run. If the T-Jet is suddenly acting abnormally, turn everything off AND unplug
the power. Make sure to unplug the USB cable between your T-Jet and the
computer as there is often data still being sent that might be corrupt. Leave
everything unplugged for a few minutes and then plug items in and start over.
You MUST cancel all print jobs for this to be effective or they may start back
up when you turn the computer and T-Jet back on.

Clean/Adjust Drive Roller and Belt
During normal operating conditions, lint that is coated
with pretreatment can get caught in the Print Head
Belt Gear located in the right rear inside of the
machine. This lint will start to clog the belt gears and
the belt will slip causing the bed to jerk and not
complete print jobs. Periodically check this gear and
if necessary, clean it with a brush or computer
vacuum. Make sure to avoid any contact with the
encoder strip as it is fragile and could get
damaged. You may need to remove the
Encoder Strip to get a good cleaning.
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Adjusting Belt Tension
Over time the T-Jet may develop some play in the belt tensioner which could
possibly cause printing problems. This is easy to check on your machine and adjust
if necessary.
Follow the basic steps below to not only check for play but to adjust tension if
necessary:

1. UNPLUG the printer.

2. Take the far side cover off your
machine (the one not holding the bulk
ink system). You will see what looks
like a black square plastic button.
Push in on the button. You should
NOT be able to push it in and if there
is any give there, you need to adjust
the pivot lever (continue to step 3).

3. Remove the cover on the other side (where the bulk ink system is located).

4. Remove the 4 screws holding the top cover that faces the rear of the printer.
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5. Loosen the screw holding the
pivot lever.

6. Push the pivot lever from the
bottom so that it contacts the
black plastic tensioner piece.

7. Tighten the pivot lever screw and
check button again. Replace
covers. Finished..

Shake shirts or Preheat to Minimize Lint
T-Shirts generate a lot of lint and it is important to minimize the amount of lint inside
the machine. Try to get in the habit of shaking a shirt before loading it. If you feel the
shirts you are using generate excess lint, use a Pet Hair pickup to quickly roll the
shirt after it is on the shirtboard. You can also preheat them in a heat transfer press
(just a few seconds) to flatten down the fibers.

Do NOT do a power purge of the print head
If the print head becomes so clogged that you can’t print a good nozzle check after 
doing numerous head cleanings, it may be necessary to replace the head. In the
past we recommend removing the print head and performing a power purge by
forcing cleaning fluid through the head. This was only marginally successful but also
caused other problems. When the head is removed the gray ribbon cable would
often not get replaced properly and would short out causing the main motherboard to
short out. Now we DO NOT recommend removing the head and doing a Power
Purge. If you do so, it is at your own risk and we will not warranty the
motherboard.
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Keep excess ink from the ribbon cable
If excess ink leaks from the print head carriage assembly to the ribbon cable it may
short out the main motherboard. When changing cartridges you should ALWAYS
wipe any excess ink from the inside bottom of the carriage around the print head
inputs with the foam tipped swab.

Five Minute Daily Maintenance
Since the introduction of white ink for dark shirts and the spraying of pretreatment
around the shop, daily maintenance has become a very critical part of your T-Jet’s
performance. By not following the required daily maintenance described below you
will void your T-Jet2 warranty as well as damage the machine.

Many of these items have been covered earlier in this manual, but the following list
will help you prioritize what key maintenance items should be done on a regular
basis.

Turn the machine off at night
Turn OFF the machine at night to make sure the print head is capped properly on
the capping station.

Perform head cleanings every morning and at the end of the shift
After turning on the machine at the start of the day perform 3 to 4 head cleanings.
Press the Ink button for three seconds as a fast way. The preferred method is to use
the Epson Cleaning Utility in the Epson driver. Perform head cleanings at the end of
the shirt run or end of each day.

Clean Capping Station and Wiper
The capping station is the rectangular piece that the inkjet head seats onto. There is
a sponge in the capping station and a wiper (small squeegee) next to it. Make sure
both are free of dried ink and garment fibers. Use a foam tipped swab, distilled
water, glass cleaner and or isopropyl alcohol.

Clean Belt and Drive Gear
Clean carriage motor drive gear and belt with a small computer vacuum or small
brush. Over time shirt fibers get caught in the drive gear causing the belt to skip.
Make sure to avoid any contact with the encoder strip as it is fragile and could get
damaged. Care also needs to be taken to not contaminate the encoder strip.

Clean Print Head
Clean any accumulated ink or garment fibers from around the sides on the bottom
side of the print head with a swab and glass cleaner.
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Clean Encoder Strip
During printing and head cleanings the clear plastic Encoder Strip that the head
reads can get dirty. The Encoder Strip is essentially the “brains” of the printer and if 
the head can’t properly read the data on the strip, the head will get confused and 
print in the wrong location dumping ink where it should not be. Clean encoder strip
with a swab and glass cleaner or isopropyl alcohol pad.

Shake up the ink
Gently shake the bulk ink bottles in the morning and night to avoid separation of
white ink pigment.

Check ink levels
Visually check the ink levels of the bulk ink bottles for the following conditions:

 Ink levels are past the full line - ink might start to drip from the print head

 Ink levels are too low - the ink tubes will run dry. .

Weekly or Monthly Maintenance
(depending on amount of production)

Clean Encoder Strip
Remove encoder strip and clean thoroughly with a clean lint free cloth and glass
cleaner or isopropyl alcohol.

Clean print head guide rails
The long round guide rails that the printing head moves back and forth on can get
dirty and in some cases dry. Wipe this weekly if dirty and use the machine oil
supplied with your printer (sewing machine oil). Give it a few drops every other
week.

Clean Belt and Drive Gear
Remove drive belt and clean with clean cloth and glass cleaner or isopropyl alcohol.
You may have to use a sharp object such as a needle or small wire brush to "Pick"
the garment fibers from the drive gear. Adjust the belt tension.
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Daily and Weekly Maintenance Schedule Check lists
The following two check lists can be used as a guide to insure critical maintenance is
performed on a regular basis. The check lists can be downloaded from
www.screenprinters.net–Click Support > T-Jet2 > Downloads
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Chapter 10
Troubleshooting

The following chapter is designed to help you find quick solutions to common
problems or questions. Remember, most of these problems can be eliminated by
daily simple maintenance like cleaning the Encoder Strip as well as the Capping
Station.

Videos are available for these procedures at screenprinters.net.

Problem:
After you print the image the color looks great, but after you cure it, the print looks
dull.
Causes and Solutions:

 The temperature is set too high on the heat press.
Make sure you test the temperature using touch less infrared thermometer or
heat testing strips. If the temperature is too hot, it could scorch the shirts and
the ink.

 There is too much pressure being applied to the shirt during curing.
When heat pressing your shirts, make sure you do not apply too much
pressure. You should not have to put a lot of pressure to clamp the heat press
down.

 Wrong type of paper used to protect the shirt when using a Heat Press
for final cure.
Make sure the paper that is used for curing is either a Teflon pad or Silicone
treated paper.

Prevention:
Get to know your heat press or dryer as there are different makes and models.
Frequently test the output temperature to make sure that what it is set to is actually
the heat temperature.
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Problem:
The print head is leaking ink and dripping ink all over the garments.

Causes and Solutions:

 The print head was damaged by crashing into shirt board, print bed etc.
Order replacement print head.

 The capping station is dirty and either not cleaning the print head
completely or adding more debris to the print head causing fibers and
debris to collect ink and ooze or drip ink.
Thoroughly clean capping station -
See the video online on how to clean the capping station.

 Debris or shirt fibers collected on print head as well as print head
carriage.
Using the reflection from the print bed, gently clean the bottom of the print
head to remove any debris, dried ink and fibers.

 Bulk system is at wrong height.
The bulk ink system is sitting too high and gravity is drawing the ink down and
out through the print head.

 Too much ink in the bulk system tanks.
If you filled the bulk ink bottles past the Full Line there could be too much
pressure in the bulk system ink lines and the ink is forced out of the print
head.

 Altitude can have an effect.
High altitudes can also have an effect on the “pressure” in the system. If you 
are having an unusual amount of problems and are at high altitudes, don’t fill 
the ink bottles too full and or try adjusting the height of the adjustable shelf
bracket. Reference Chapter 2 Installing Ink System

Faulty bulk system, call technical support.

Prevention:
 Always check height of print head prior to printing.
 Clean capping station on a regular basis.
 Clean debris from print head daily.
 Don’t over fill ink bottles.
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Problem:
The printed image is wiping off, washing out, fading badly, or bleeding.
Causes and Solutions:

 Garment was improperly cured.
Inks need to be brought up to approx. 330-345 degrees F. for 45 - 60 seconds
for white garments; 120-180 seconds for darker garments

 Too much or too little pressure applied when heat pressing.
When pressing the garment the top of the heat press should gently rest over
the silicone paper. This allows the moisture of the inks to escape and properly
cure.

 Temperature of heat press is not correct (Either to hot or too cold).
Make sure the heat press is heating up evenly or correctly (Should be 330-
350 degrees F). You can test this with a touch less infrared thermometer or
heat testing strips.

 Pretreatment improperly applied.
Pretreatment may still be wet, simply cure longer.

 Poorly pretreated.
Apply more pretreatment on successive shirts and cure again.

 Too much pretreatment.
Use less pretreatment in future.

 Type of fabric being printed.
For best results print onto 100% cotton! With 100% colors will look their best.
For 50/50 blends of cotton and polyester ink needs to be cured quickly to
reduce possible bleeding.

 How the garment is being washed.
Wash in cold water and dry with delicate dryer settings.

Prevention:

 Make sure heat press is heating up evenly and correctly.
 Heat press should lightly press garment.
 Pretreat evenly and away from printer.
 Cure Pretreat properly.
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Problem:
The printed colors donot look correct. They don’t look like what you see on the
computer monitor prior to printing.

Causes and Solutions:

 Your print head nozzles could be clogged.
o Run a nozzle check on a piece of clear film to see how the nozzles are

firing.
o Clean the capping station, wiper assembly and the bottom of the print

head.
o Check the clear tube with a green stripe and make sure the end is not

clogged.
o Run a head cleaning and a nozzle check in repetition to see

improvement.
o Use the refillable cleaning cartridges to run head cleanings in repetition

to see improvement.

 The image has an attached ICC Profile.
FastARTIST uses its own ICC Profile; make sure you do not apply one out
your preferred graphic program. Refer to your graphic program’s user manual 
on ICC profiles.

 You have an ICC profile checked in Corel Draw.
Go to File/Print and select the Masc. Tab. Uncheck Apply ICC Profile.

 The capping station is not working properly.
o Clean the capping station, wiper assembly and the bottom of the print

head.
o Check the clear tube with a green stripe and make sure the end is not

clogged.
o Inspect the clear tube with a green stripe and make sure it is

dispensing ink correctly.
Prevention:
Usually when a color prints out wrong it is because a nozzle is clogged. If you are
trying to print out an orange image but all that prints out is yellow, that means the
magenta is clogged and the pigment can’t mix to produce the orange. 
The biggest part of your T-JET to check for is the capping station. Make sure this
ALWAYS stays clean. The print head uses this to dock when the printer is not in use
to ensure the print heads do not dry out. This is also used during a head cleaning
and if the capping station is dirty, the printer can not do a head cleaning properly,
thus not working out the nozzle clog.
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Note: When building any image inside any software program, make sure you always
use an RGB color mode because this is how your monitor views colors. Never apply
an ICC profile.

Problem:
The prints are out of register or there are large gaps in
the print.

Causes and Solutions:

 Different print modes are being used.
Double-check settings in FastRIP setup and make
sure all print modes are of same type. If using an
HS print mode for the color then the same must be used for the underbase
(i.e. Photo 720 Standard HS print mode and 1440dpi Image Normal
underbase HS).

 Encoder strip is dirty and needs to be cleaned.
Clean encoder strip.

 If underbasing and using the underbase wizard the black and white
versions of images are different sizes.
Double check the image height and width to make sure they are same size.

 Print bed not moving at same pace as print head.
Call technical support.

 Print head carriage jumping around and causing it to misread encoder
strip.
Clean belt drive and drive belt gear.

 There is a communication error between your T-Jet and your computer.
Make sure you don't have any jobs in the FastRIP or Epson Queue's, if you
do delete them. Then power down your T Jet & unplug the power & let it set
unplugged for about 30 seconds. Power back on and try again.
You can also make sure you are set to use the correct port within FastRIP.
Open up FastRIP, select Printers/Manage Printers, make sure that you are
using the Epson Stylus port and that the control panel box has a check mark
in it.
Another possibility is the type of cable you are using. We highly recommend
using a USB cable as the best connection, DO NOT use a long cable, switch
boxes, or hubs.
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Earlier versions of FastRIP would sometimes create a new port called
PS Passthrough.

You may need to delete this port:
1. Make sure the port is set to Epson Stylus... in the Manage Printers

menu in FastRIP.
2. Open the Printers & Faxes menu from the Start button in Windows and

open the PS Passthrough Queue, delete any pending jobs.
3. Right-click on the PS Passthrough, select delete to remove it.
4. Power down the T-Jet and unplug it for 10 seconds.

Tip: As long as the Epson Stylus port is selected Windows will not install the PS
Passthrough.

Prevention:

 Always double check settings for FastRIP prior to sending a print job to
actually print.

 Clean the Encoder Strip weekly or as needed depending on your production
rate.

 Always make sure that images are the same size when using the Underbase
Wizard in FastARTIST.

 Keep T-Jet as clean as possible and perform normal maintenance.
 Check the communication between the computer and printer.

Problem:
The Fonts are not printing correctly on the garment as they do on the computer
screen.

Causes and Solutions:

 Sometimes Fonts, especially script Fonts, may not print correctly or
print at all. This tends to happen in Vector Programs.
The T-Jet2 driver may not download the Font correctly causing the image to
print incorrectly. Simply change the Font to a graphic image. Depending on
the graphic program, it may be called Convert to Curves or Create Outlines.
You may also need to do this if you are printing vector fonts along with a
bitmap image.
Try importing or printing a different file to see if the problem remains.
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Problem:
When you print a white underbase you get a white box over the entire image.

Causes and Solutions:

 Check your underbase setup within
FastARTIST.
Within FastARTIST go to File >
FastRIP Setup > Underbase Setup tab.
Make sure the top checkbox that
says Underbase all items with this
underbase color is checked and the
bottom check box that says Highlight
all objects with this color is NOT
checked.

Make sure to view the image in the
FastRIP View Raw Data viewer to see
if it looks correct BEFORE printing.

Please note: If you chose the 1440dpi one
pass white print mode you will not be able to
view the raw data.

Problem:
When printing white ink, no white ink prints or there are no Underbase settings
available.

Causes and Solutions:

 You do not have the correct
printer selected in FastRIP.
Open up FastRIP. Go to
Printers/Manage Printers and
make sure your printer is setup as
a T-Jet2. If it is NOT setup as a T-
Jet2, FastRIP doesn't know that it
needs to use the white ink.
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Problem:
Individual ink lights are flashing.

Cause and Solutions:

 The printer thinks you are out of a
specific color.
The ink cartridges have auto reset chips
on them but if you have been printing a lot
of shirts the chips have not had a chance
to reset.
You can turn the printer off for 30 seconds
and then back on BUT if you are in the
middle of a job, you will lose a shirt.
You can also push the Ink button once.
The carriage will move out so you can remove the cartridges. Lift the cartridge
that has a light flashing just enough so it disconnects from the contacts on the
print head. Wait about three seconds and push the cartridge back down.
Press the Ink button again and the carriage will return to home position. The
lights should go out and the printer will start to print again.

Prevention:
Get in the habit of turning the printer on and off between print jobs that use a lot of
ink or need a large number of prints.

Problem:
When you send a print job to the printer nothing happens.
Cause and Solutions:

 The computer is not
communicating with the printer.
Check the port settings in FastRIP.
In the FastRIP window go to
Printers/Manage Printers. The port
should be set to Epson stylus
photo 2200_usb00*. Check the
Control Panel box on the right.
Make sure there are no other jobs
already in the print queue.
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 Is the green power light flashing? If not, the job did not make it to the
printer.
Check your printer cable connections.

 The printer is not ready to print the job.
o Make sure the bed is in the load position. Press the Load button.
o Check and see if any of the ink cartridges are showing empty.
o A shirt may be blocking the sensor. If the Load light is flashing, check

the shirt height and see if anything is obstructing the sensor. The small
sensor light is Amber when blocked and Green when ready to print.

PhotoScript PS Passthrough is causing problems.
Remove the PS Passthrough port.

Problem:
The color of the shirt is showing through the under base.

Causes and Solutions:

 There is not enough pretreatment on the shirt.
o Use a good spray gun such as the Wagner Control Spray to lay down

an even coat of pretreatment.
o Press the shirt in a heat press before pretreating; this will press the

fibers down allowing the pretreatment to stick to the shirt better.
o Make sure you are applying the pretreatment in nice smooth, slow and

even strokes.
o Be sure to cover the entire printable area.
o Use 100% pretreatment. Try not diluting it with water to see if prints

improve.
 The white nozzles are clogged.

o Run a nozzle check on a piece of clear film to see how the nozzles are
firing.

o Clean the capping station, wiper assembly and the bottom of the print
head.

o Run a head cleaning and a nozzle check in repetition to see
improvement.

o Use the refillable cleaning cartridges to run head cleanings in repetition
to see improvement.
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 The underbase settings in FastARTIST are not strong enough, or not set
up correctly.
Check you’re underbase settings and compare them to the default settings in
Chapter 6 - Printing White Ink. (Keep in mind, every image will vary; this is
just a starting point).

 The white ink cartridges are not primed all the way.
Pull out the white cartridges and use the syringe to re-prime them.

Run more head cleanings to get possible air out of the lines.

Prevention:

o Make sure you get the hang of pretreating a shirt. The best way is to
just jump in and try it out. Each person will develop their own special
way to apply pretreat to a shirt.

o Try pressing your shirts before applying pretreatment as this will press
the fibers down, making sure the pretreat sticks to the shirt and not the
fibers sticking up.

o Perform regular machine maintenance. Keeping your machine clean is
the most important part to having great prints on a dark shirt.
Frequently run head cleanings and nozzle checks to keep your nozzles
firing properly. Take the time to get to know your machine and your
software. Make sure you start off using the default under base setup
settings provided in the Printing White Ink chapter.

Problem:
There is horizontal banding across print (in one or all
colors).

Causes and Solutions:

 Ink in the nozzle opening has dried out from
exposure to air for an extended period.

o Do head cleaning and printing nozzle
checks until a decent nozzle check is achieved.

o Place cleaning cartridges or bulk cleaning system in and run head
cleanings and printing nozzle checks until a decent nozzle check is
achieved.

o A serious or permanent clog of the head may require replacing the
print head.
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 The capping station is dirty and is not
cleaning the print head completely. This
will just adding more debris to the print
head causing print head to become
clogged.
Thoroughly clean capping station. It can be
cleaned with swabs included in maintenance
kit and glass cleaner. Be sure to clean the rubber seal around the capping
station as well as the rubber wiper blade.

 Air bubbles in bulk system tubing causing small amounts of ink to dry
inside print head/nozzles.
Re-prime bulk system using syringe. Once system is re-primed run head
cleanings and print nozzle checks till a decent nozzle check is achieve.

 You are using a 360 dpi Print Mode or a high speed (HS) Print Mode and
the heads are not in perfect alignment.
Align the heads or use a 720dpi Print Mode. A 360 dpi Print Mode is the
fastest but lowest quality where head clogs or misalignment will show as
banding.

Prevention:
o Clean capping station daily!
o Run head cleanings before printing in the morning as well as printing a

nozzle checks to gauge status of print head prior to printing onto
garments.

o Ensure breather caps are free of ink prior to printing or remove breather
caps while printing.

o Make sure bulk system tubes don’t have any air in them prior to printing.
o Perform a Head Alignment.

Problem:
Printer stops in the middle of a print routine and stops communicating with the
computer.
Causes and Solutions:

 Print drivers may need to be re-installed.
Print drivers are prone to occasionally lose communication with Windows XP
operating system. The simple solution is to re-install the driver.

 Too many items in USB port.
If you have too many items in the USB port unplug everything but the mouse
and the T-Jet. This is due to a limited USB power generated from the ports.
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 Image file may be corrupt.
The file being printed may be corrupt. Try another file.

 USB cable may be too long.
Your USB cable should not be MORE than six feet in length.

Prevention:

o Keep it simple. Do not overload the printer port.
o When in doubt first try turning everything off and unplugging such as the

USB cable from the computer to the printer.

Problem:
Files take a long time to print.

Causes and Solutions:

 Printing from Corel Draw is causing large spool files.
Printing from Corel Draw, any version, can create extremely large of spool
files. This happens when one or more copies are sent to print when you are
trying to print a number of prints that are making a second pass. It can also
happen if bitmap images are placed in the document. If the spool files are
larger than your physical memory, the file may not print or take a long time
processing. Ways to reduce this is to export the file as a JPG file format, then
bring the file back into Corel Draw using the Import function. If the bitmap was
created in Adobe Photoshop, open it in Photoshop. Reduce the resolution to
around 200dpi. Save this file and Import it back into Corel Draw.
Try to print from a different program like Adobe Photoshop, Acrobat Reader,
or Adobe Illustrator. These graphic programs do not create as large spool
files as Corel Draw.

 File resolution is too high.
Resolutions of 150 to 225 dpi (at the final print size) are all that is necessary
for direct printing to garments. If you receive larger file resolutions, resample
them down to a lower resolution to speed up ripping and printing times.

Prevention:
Keep file sizes small if possible and don’t send a lot of print commands from Corel at 
the same time.
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Problem:
The printer is printing large bands of color, vertical colored lines, or printing partial
images.

Causes and Solutions:

 You have a dirty Encoder Strip or Encoder Sensor behind the print
head.
The Encoder Strip is the heart of the machine. It has information on it that the
Encoder Strip sensor behind the print head reads as the print head moves
back and forth. If there is ANY contamination, pretreatment, dirt, ink or debris
on the Encoder Strip or on the Encoder Strip Sensor Eye, the printer will be
VERY CONFUSED. This is the #1 cause of abnormal printing problems.
Clean the Encoder Strip with Glass Cleaner. It may be necessary to remove it
from the machine. You may need to clean the Encoder Strip Sensor behind
the print head with a pipe cleaner or swab.

 The second Encoder Wheel and Reader
inside the printer has moved out of
position.
As you face the front of the T-Jet, remove
the left hand cover (opposite the Control
Panel). There is a clear plastic wheel with a
Reader Sensor. If you transported the
printer or bumped it hard, there is a chance
the Reader Sensor is out of place or off the
guide holds. Reposition the Reader.

 When the Reader is out of place the printer will skip areas of an image
and then start to print again.

 The drive gear for the belt may be filled with link and slipping.
Clean the gear.

Prevention:

o Keep the printing area clean, the machine lid closed, and pretreat shirts
away from the printer.

o Shake shirts before you print them to remove excess lint that may get on
the Encoder Strip.

o When printing non-stop in heavy production, clean the Encoder Strip often
to prevent the machine from spoiling shirts during a printing cycle.
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Problem:
Red ink lights are flashing or solid and the printer will not print.

Causes and Solutions:

 If all the lights are flashing, the T-
Jet may be having communication
issues with the computer.
Turn the printer off and unplug it from
the wall and the USB cable for a few
minutes.

 The Maintenance Tank Counter
may need to be reset.
If the printer thinks that you have
done about 10, 000 to 15, 000
“pages” you will need to reset the
Maintenance Tank Counter. Contact Technical Support for reset directions.
There is an excellent software program that will automatically reset the printer
without having to take off a cover or get inside of the machine. Call Tech
Support for details.

 The printing head may have hit an object as the carriage moves across
the garment.
If the head does not find home when it tries to print, it can get confused.
Check for obstructions and make sure that the capping station has not come
out of place causing the head to not find home.

 Ink cartridges may not be seated all the way or they could have a bad
chip.
The chip on the ink cartridge is not connecting properly to the prong inside the
print carriage. Press the Ink button on the printer. This slides the Print
carriage over. Take the ink cartridge out slightly and snap it back into place.
Press the Ink button again. If the ink light(s) are solid red then turn the printer
off. Take the ink cartridge completely out and snap it back in. Turn the printer
back on. If the T-Jet printer still has a solid red ink light(s) then replace the
chip on the ink cartridge with the extra chips sent with bulk ink system. You
can also clean the contacts on the chip with a pencil eraser.

 Ink cartridge holder has bent prongs that do not make good contact
with the chip.
When you insert an ink cartridge, the small chip on the back makes contact
with gold prongs. These prongs can be pulled out of place if the chip is not
installed correctly on the cartridge (sticking out of the slot) or if the prong
hangs on the cartridge as it is being removed.
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 NEVER insert a cartridge without a chip or you will pull the prongs loose
when you remove the cartridge.

Prevention:
There are a number of reasons the printer may have red lights flashing or solid.
Keep the Encoder Strip clean, make sure the printing head finds home, and that the
cartridges do not have bad chips or poor chip connections.

Problem:
The quality of the printed output is unacceptable when printing bitmap images. The
images seem soft and are not clean and sharp.

The resolution at the final size in 72dpi.

Causes and Solutions:

 The resolution of the image is too low.
Resolution at 72dpi is for viewing the image on a computer monitor only.
Images intended for printing need to be between 150 and 225dpi to maintain
a clean and sharp image. You can try upsampling the image to a larger
resolution but the image still will be “soft” when printed.

Problem:
When sending a print command to the T-Jet2 printer the Print Head moves like it is
printing but no ink sprays out.

Causes and Solutions:

 Ink is not flowing from the Bulk System.
This is caused by a vacuum being created in the bulk system. Unscrew the
top of each bottle then reseal.

 Ribbon cable to the print head is burnt or not connected.
If you accidentally splash/drip ink or cleaning fluid on the gray ribbon cable
that connects to the print heat, it can short out. Check for burn marks on the
ribbon cable connectors and that the cable is connected properly. This can
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happen if you replaced a print head and did not make sure the cable was
attached properly.

 Main Computer Board is bad.
There is a chance the main board in the printer is bad. The board could have
a defect or might have had ink or cleaning fluid spilled on it. If ink or cleaning
fluid runs down the ribbon cable or drips into the bed it can short out the main
board (or boards). In this case the safety fuse would fault.

 Capping Station Clogged.
The capping station may need cleaning. If the printing head did not seat
properly, ALL of the print heads could be clogged as well as the hose with the
green stripe that drains the excess ink into the waste bottle. This would
prevent the capping station from draining properly.

Problem:
Lights are flashing on the Control Panel

Causes and Solutions:

 Green Power button and Ink lights are flashing.
The Maintenance Tank Counter may need to be reset. If the printer thinks that
you have done about 10, 000 to 15, 000 “pages” you will need to reset the 
Maintenance Tank Counter. Contact Technical Support for reset directions.

 Green power light flashes.
The printer is receiving data, replacing an ink cartridge, charging ink, or
cleaning the printer head. This is a normal function.

 Error Eject button light is on.
The printer has received an error in the data if there is no media loaded or if
there is a wrong size sheet fed. Only press the Error Eject button at the
loading position instead of the Load button. The Error Eject button may also
be lit if the printer is waiting for the Load button to be pressed when doing
multiple print passes.

 Green power button, Error Eject button flashing.
The printer is being jammed or blocked by foreign object that must be
removed before continuing.

 The Green Load button is flashing.
The printing bed sensor is being blocked by a shirt or obstruction. Remove
the obstruction and press the Load button to continue printing.
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Problem:
The image is printing off of the shirtboard or in the wrong location.

Causes and Problems:

 You have a mismatch in the software settings.
Make sure you have the working “page size” set the same as the final printed
page size. You can work on one page size in a graphics program but print to
a different page size causing the image not to print in the correct location.
Select Standard Board in FastARTIST/FastRIP.

Printing Head Hitting the Print Bed
When the T-Jet2 printer is shipped or transporting the printer bed may have shifted or
the bed carriage may have moved a little. This will cause the printing head to hit the
bed.
On both sides of the T-Jet2 are 2 screws that can be undone and the lever moved to
lower and raise the Print Head. Take off both side covers. Loosen the 2 screws.
Move the Print Head across the bed. If the Print Head hits the bed, STOP. Move the
white lever to the left or right. You will notice the Print Head move up or down. Move
the lever until Print Head does not hit the bed. Move the bed to the front, middle, and
back when moving the Print Head across. Once a point is reached when the Print
Head does not hit, tighten the 2 screws. Put the covers back on.
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Chapter 11
Transporting Printer

If you plan on transporting your T-Jet2 from one location to another, it is essential
that you following the steps below. Failure to do so could not only cause serious
damage to your T-Jet2 but possibly void your warranty. The preparation process
should only take about 10 minutes and if you have any questions regarding any of
the steps, please call our support department during regular business hours as
follows:

Toll Free +1 888-MYTJETS (698-5387)
Technical Support +1 480-929-2937
Corp. Office +1 480-929-0640
Fax +1 480-929-0766
Email: support@usscreen.com.
Internet: www.ScreenPrinters.Net Click on Support
Support hours: 7:00am to 8:00pm Monday through Friday

9:00am to 3:00pm Saturday
(Mountain Standard Time) USA

Note: Arizona does not observe “Daylight Savings” in the US. 
In the summer months, Arizona is on the same time as California.

Installing the T-Jet Cleaning System

Every T-Jet is shipped with 28 Ink Line Caps. All 28 Ink Line Caps may be used to
complete this process so when they are not being used be sure to store the Ink Line
Caps in a safe place. You should have 14 Red Ink Line Caps and 14 White Ink Line
Caps.

1. Remove ink line from cartridges and cap the
end of each ink line with a red ink line cap. Be
sure to remove and cap each line individually to
avoid ink siphoning out onto the cartridges.
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2. With the white ink line caps, now cap each bulk system
ink cartridge.

3. At this time you can remove the ink cartridges simply
by pushing cartridge tabs inward as shown in this
example. This will then release the cartridge from the
print carriage.

Important note about storage of ink cartridges: When the ink cartridges are
removed make sure to place them upside down as this will prevent ink from leaking
out. We also recommend that the bottom of the ink cartridge be taped and placed in
an individual plastic zip lock bag.
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4. Leave the ink bottles on the adjustable shelf and
simply place a piece of tape across the bottles to
secure to the T-Jet2. There is no need to
disconnect and cap the ink lines and bottles.
If you are using the Ink System Holder, remove
bottles and holder from the side and place in a
box for transportation. The waste bottle will be
placed on the print bed and secured to the T-Jet
with adhesive packing tape in an upright position.

5. Tie loose ink lines to cable chain with zip tie. This will keep the ink lines from
moving around and possibly damaging the encoder strip. Make sure to allow for
a natural bend in the ink line; DO NOT kink the ink lines.

Important Note: There is no need to remove the Cable Chain when transporting the
T-Jet2.

6. Install the Refillable Cleaning Cartridges
and perform 5 to 6 head cleanings. When
performing a head cleaning with the
cleaning cartridges the bottom rubber plug
must be removed. If the rubber plug is not
removed during a head
cleaning –damage can be
caused to the print head.

1

2

2

3

3
3
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IMPORTANT NOTE: DO NOT RUN A NOZZLE CHECK WITH
CLEANING CARTRIDGES.
Cleaning solution will leak out into T-Jet causing serious damage.

To purchase Refillable Cleaning Cartridges contact:
Equipment Zone Sales:
Monday - Friday 8:30a.m. -6:00 p.m. (EST)
Main Line and Sales (201) 797-1504
Toll Free Order Line 1 (800) 408-0040
sales@equipmentzone.com

7. Place rubber plugs back into the bottom of the
refillable ink cartridges to keep cleaning fluid from
leaking out during transportation.

8. Turn the printer OFF by pressing the Power button only. As the printer powers
down the print carriage will move onto the docking station. The docking station is
located on the control panel side of the printer.

EJECT LOAD INK ERROR
EJECT

POWER
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Securing the Print Head

1. Place print carriage shipping bracket on printer using adhesive packing tape to
properly secure. If the print head is not properly secured during transportation,
damage may occur to the print head.

Note:If you do not have the carriage shipping bracket then tape the print carriage to
the control panel side of the T-Jet using adhesive packing tape.

2. Raise the printing bed until the metal surface is to the
top lip of the printing bed.

Place Tape Here Place Tape Here
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Securing the Print Bed

1. Move the printing bed to the middle of the track on the printer. Using
a Phillips head screwdriver install the bed brackets and tighten for all
four corners.

2. Close the Waste Bottle Valve - Anytime that
the T-Jet2 is powered off make sure to close the
waste bottle valve to prevent cleaning solution
from siphoning through the capping station.

3. Place the waste bottle in an upright position on
the print bed and secure to the T-Jet2 with a
piece of adhesive packing tape.

4. Pack the T-Jet2 back into its original box for transportation. Failure to do so
will void your warranty.

The T-Jet2 is now safe for transportation, just make sure when picking up the T-Jet2
to do so with 2 people and observe the following holding points.

Do Not lift your T-Jet2 by the print bed.
Lift underneath the side panels. Lifting
by the print bead alone may cause
serious damage.
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Chapter 12
Product Support

Support Policy
Support for T-Jet2 is free. The machine is very easy to use and intuitive. Most
support questions have to do with using FastARTIST, FastRIP, or printing from
specific graphic applications.
For the quickest support, email your question to support@usscreen.com. Be very
specific and include your serial number.
If you bought the printer from a dealer in the USA, you DO NOT have to go
back to the dealer for support. Simply call or email our support lines. If you
bought the printer from a dealer outside the USA, you need to contact your
dealer for support and then if necessary, contact us. Remember, we have
dozens of short videos online about many of the items covered in this manual.

Support Hours
Toll Free +1 888-MYTJETS (698-5387)
Technical Support +1 480-929-2937
Corp. Office +1 480-929-0640
Fax +1 480-929-0766
Email: support@usscreen.com
Internet: www.ScreenPrinters.Net Click on Support
Support hours: 7:00am to 8:00pm Monday through Friday

9:00am to 3:00pm Saturday
(Mountain Standard Time) USA

Note: Arizona does not observe “Daylight Savings” in the US. 
In the summer months, Arizona is on the same time as California.

Phone Support
T-Jet2 support is not toll free. We have a very competent staff of support specialists
who will gladly walk you through procedures. When calling for support, please have
your serial number and a detail of the problem at hand. If you have received an error
message, please include the error number. It is often easier if you fax or email a
support question before calling for help.

1
6
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E-mail Support
Email support is available at support@usscreen.com. Keep in mind that even
though you can email 24 hours per day, the support department is only available
during the above hours. For email support, please include your full company name,
contact name, phone, address, serial number and a detailed description of the
problem.

We now have Web CAM video support!
You can purchase an inexpensive web cam for your computer and talk LIVE to one
of our support technicians. More information about how to use this amazing support
technology is on the T-Jet Support page at www.ScreenPrinters.Net.

Free Internet Web Support
Access support documents on the internet at www.ScreenPrinters.com. Simply
click the Support link located on the home page. The Support area is designed to
keep you up to date on current changes and upgrades.

Epson Support
T-Jet2 is a highly modified version of an Epson 2200 with hundreds of additional
parts not provided by Epson. The T-Jet2 is NOT supported by Epson. We provide
the Epson 2200 Printer Driver as a convenience with Epson’s approval, butEpson
will not support this driver.
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Third Party Software Support
We will make every attempt to help with printing from programs like Corel Draw,
Photoshop, Illustrator, etc., but we do not offer free support or training on these
programs.

Training Classes for the T-Jet2
We now offer one day hands-on training
classes for the T-Jet2 in our Tempe
(Phoenix) location and at Equipment Zone
in New Jersey. We get rave reviews about
how these classes really give students
confidence on how to use and maintain
their T-Jets.
For more details check out the Fast T-Jet
website at www.ScreenPrinters.Net.

Show off your work
If you want to brag about the things
you’ve printed on your T-Jet. We
have a new ScreenPrinters.Net
Gallery where you can upload
pictures of jobs you have done.
Check it out at
www.ScreenPrinters.Net.
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Appendix A
Printing with a Seven Color T-Jet Without

White Ink Capabilities
Earlier models of the T-Jet did NOT have
white ink capabilities. From November
2004 and October 2005, the red T-Jet
with seven ink colors (cyan, light cyan,
magenta, light magenta, yellow, black
and light black) was the current model.
In late October of 2005 the red machine
was phased out and the new T-Jet2 was
introduced with white ink capabilities -
four colors of cyan, magenta, yellow and
black plus white in three of the color
slots.
If you have a red machine or a T-Jet2 without white ink capabilities, this section will
help you print from your T-jet. 85% of this manual will work with the red T-Jet. The
base print engine is still the Epson 2200 printer. The buttons are the same and the
basic working of the machine is the same.
The main difference between the T-Jet and the T-Jet2 is that the T-Jet2 has a
deeper and longer printing bed, obstruction sensors, print pass counter (some
models), different bulk ink system, white ink capabilities, and the FastRIP and
FastARTIST software.

Red T-Jet Setup
The two main differences between the T-Jet and T-Jet2 are how the printing bed
attaches and how the bulk system attaches.

Printing Bed Track Setup
1. Remove the two temporary holding braces for

transportation placed on the front and back of the
printing bed. You will have to remove the Height
Adjustment Dial on the Ejecting end of the unit to
remove the bracket. Replace this dial after the
bracket is removed. Retain these braces for future
shipping or transporting of the unit. You can move or slide the Printing Bed to
gain easier access when attaching the Tracks.

1
6
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2.  Place “Tracks” where brackets were located and use 
the same screws to fasten tracks on each end.

3. Adjust the leg on each track so the track is flat. If
the tracks on both sides are not flat and level to the
track on the unit, the printing bed tray might bind up
during movement. If the printing bed tray stops
(during the loading process) and the motor hums or
seems to still be trying to move the bed, the track is
not level. You can use the Height Adjustment Guide
to make sure the track is level and straight when
attached.

Bulk Ink System
The bulk system sets on a support tray
that will prevent it from ever falling off or
accidentally getting knocked off. You will
need to attach the tray to the side of the
printer. The tray is not shipped installed
because its location and size might cause
damage to the unit if the machine is
dropped or the box rolled. The tray
screws onto the side of the printer and
Velcro is used to hold the bulk system in
place.
Note: The seven containers need to be
filled with ink.
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Creating Special Print Modes
Standard T-Jet Only without White capability

When printing to a chrome T-Jet2 you MUST use FastARTIST and FastRIP because
you have white ink in three of the “color” slots on the bulk system. When printing to a 
red T-Jet, you can print with the standard Epson 2200 Printer Driver and your own
custom Print Modes designed for printing on garments.
Even though the standard Epson printing modes designed for paper could be used,
the prints may not be as bright as you want. In the Epson driver you can change
settings that tell the printer to lay down a “denser” deposit of ink and to increase the
color saturation in order to get more vivid prints with good coverage on textile
fabrics. As you build up more experience with Fast T-Jet, you may want to build your
own custom Printing Modes.
You will need to build six new Print Modes called Advanced Custom Settings, in the
Epson driver. The final Print Modes are very similar on both Mac and PC but they
are built differently on each platform. Making Print Modes is a one time effort. Once
built, you will simply print to the Epson driver and “load” your favorite Print Mode
depending on the type of image being printed (cartoon, non-critical, photorealistic,
etc.).

Getting started creating Custom Print Modes - Windows
Open the Epson printer driver. The simplest way is to open your favorite graphic
application, create a small graphic and act as if you were going to print it out by
choosing the Epson 2200 as the printer. Once at the choose printer menu in your
program, simply select Properties.

Work from the Advanced Menu
The process of building your Printing Modes starts from the Main Epson Driver
Menu. Ignore the settings on the Main Page and select the Advanced button. This
changes the Basic page to a page with more Advanced controls.
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Note: The Adobe Illustrator CS, Adobe InDesign, and Macromedia Freehand
printing window may look different. Refer to your individual graphic programs User’s 
Manual.

Setting the printing “page” size
In the Advanced Main Menu of the Epson 2200 printer driver, drop down the Letter
Size menu and select User Defined. Your Fast T-Jet printer has a Printing Bed Size
of 13” x 18” (33 x 48cm). Because we are printing to an inkjet printer, we need to tell 
the printer driver what our standard paper/shirt image size is.

You can also make your own “paper” sizes for odd size items, or simply work on a
13” x 18” (33 x 48cm) page size and make a printing Template to work from. Keep in 
mind that the upper left corner of the “page” is the same as Zero on the rulers that 
are mounted on your printer. Type in the correct size (13” = 1300) and give the page 
a name. Press the Save button and the page size will now be available when you go
to print.

Creating Custom Print Modes - MAC OS X
In Macintosh OSX, go to File/Print. Select
the Stylus Photo 2200 printer. Bring Copies
and Pages down and select Print Settings.
Work from the Print Settings Menu (Mac OS
X). You need to start to build your Printing
Modes from the Main Epson Driver Menu.
There are three main menus to use during
setup; Print Settings, Color Management,
and Ink Configuration. Go to File/Print.
Select the Stylus Photo 2200 printer driver. Bring Copies and Pages menu down.
Select Print Settings.
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Print Settings
Allows you to choose your Media Type, Advanced settings, and High Speed.

Color Management
Set your Color Controls.

Ink Configuration
Set the Color Density of the image.

Setting the printing "Page" size - Mac OS X
Go to Page Setup or Print Setup. Under Format select
the Stylus Photo 2200 printer driver. Bring the Paper
Size menu down and select the desired page size.
Your Fast T-Jet printer has a Printing Bed Size of 13" x
18" (33 x 48cm). Because we are printing to an inkjet
printer, we need to tell the printer driver what our
standard "paper" size is.

You can also make your own "paper" sizes for odd size items or you can simply
work on a 13" x 18" (33 x 48cm) page size and make a printing Template to work
from. Keep in mind that the upper left corner of the "page" is the same as Zero on
the rulers that are mounted on your printer. Bring Page Attributes menu down.
Select Custom Paper Size. Click New. Name the Paper Size. Below enter the
Height, Width, and Margins. Click Save. Bring the Custom Paper Size menu down,
select Page Attributes. Bring Paper Size menu down. Select the new Paper Size.
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Getting started creating Custom Print Modes - Mac OS 8.6 - 9.2.2
In Macintosh 8.6 - 9.2.2, go to Apple
menu/Chooser. Click and highlight SP 2200.
Close the Chooser. From the graphic program, go
to File/Print. From here you will need to start to
build your Printing Modes from the Main Epson
driver menu using the Custom/Advanced options.

Setting the printing "Page" size (Mac OS 8.6 - 9.2.2)
In the Page Setup/Print Setup menu of
the Epson 2200 printer driver, bring the
Paper Size menu down and selected
desired page size. Your Fast T-Jet has a
printing Bed size of 13" x 18" (33 x
48cm). Because we are printing to an
inkjet printer, we need to tell the printer
driver what our standard "paper" size is.
You can also make your own "paper"
size for odd items or you can simply
work a 13" x 18" (33 x 48cm) page size
and make a printing Template to work from. Keep in mind that the upper left corner
of the "page" size is the Zero point for the printing bed. Click on the Customize
button. Click New. Name the paper size, Width, Height and margins. Click Ok.

Special Fast T-Jet Printing Modes - Windows

Cartoon 360dpi (Windows)
Typically, a cartoon or simple spot color image
needs to be printed as bright as possible. By
doing extra ink color saturation the colors are
richer. Over saturating a full-color photograph can
cause muddying of the image so these settings
should be used for non-critical spot color or
cartoon type images.
1. Choose the Advanced button from the Epson
printer driver Main Menu.
2. Leave the paper set to Plain Paper.
3. The top grouping of selections should be set
for Sheet, Plain Paper, Normal - 360dpi and 13” x 
18.”
4. All buttons on the left side should be unchecked and
Orientation set to Portrait.
(Note: High Speed is checked but is not available.)
5. Color Management should be set for Color Controls
and Gamma 1.8.
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6. Color Mode should be set for Epson VIVID Color.
7. Saturation should be set to +25%. Magenta and Yellow to +5%.
8. Click on Ink Config and set Color Density to +20%.
9. Save this setting as TJ-Cartoon-360.

Cartoon 720dpi (Windows)
1. Choose the Advanced button from the
Epson printer driver Main Menu.
2. Set the paper to Enhanced Matte Paper.
3. The resolution to Photo 720dpi and the
paper size to 13” x 18.”
4. All buttons on the left side should be
unchecked and Orientation set to Portrait.
5. Color Management should be set for Color
Controls and Gamma of 1.8.
6. Color Mode should be set for Epson VIVID
Color.
7. Saturation should be set to +25%.
Magenta and Yellow to +5%.
8. Click on Ink Config and set Color Density to
+20%.
9. Save this setting as TJ-Cartoon-720.

Cartoon 720dpi High Speed (Windows)
Follow the exact steps for Cartoon 720dpi but check High Speed.
Save this setting as TJ-Cartoon-720HS.

Photo 360dpi (Windows)
For images that are photorealistic or have skin tones and reference colors, you need
to create Print Modes that are more accurate with less color saturation. These will be
called the Photo modes.
1. Choose the Advanced button from the Epson
printer driver Main Menu.
2. Set the paper to Plain Paper.
3. The resolution to Normal - 360dpi and the paper
size to13” x 18.”
4. All buttons on the left side should be unchecked
and Orientation set to Portrait.
5. Color Management should be set for
PhotoEnhance.
6. Set Tone to Hard and Effect to Sharpness.
7. Click on Ink Config and set Color Density to
+20%.
8. Save this setting as TJ-Photo360.
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Photo 720dpi (Windows)
1. Choose the Advanced button from the
Epson printer driver Main Menu.
2. Set the paper to Enhanced Matte
Paper.
3. The resolution to Photo - 720dpi and
the paper size to13” x 18.”
4. All buttons on the left side should be
unchecked and Orientation set to Portrait.
5. Color Management should be set for
PhotoEnhance.
6. Set Tone to Hard and Effect to
Sharpness.
7. Click on Ink Config and set Color
Density to +20%.
8. Save this setting as TJ-Photo720.

Photo 720dpi High Speed (Windows)
Follow the exact steps above but check High Speed.

Save this setting as TJ-Photo-720HS.

Special Fast T-Jet Printing Modes–MAC OS X
(If creating Print Modes for Mac OS 8.6–9.x contact technical support for details.)

Cartoon 360dpi (Mac OS X)
Typically, a cartoon or simple spot color image needs to be printed as bright as
possible. By doing extra ink color saturation the colors are richer. Over saturating a
full-color photograph can cause muddying of the image to so these settings should
be used for non-critical spot color or cartoon type images.
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1. Go to File/Page Setup or Print Setup. Under
Format select the Stylus Photo 2200 printer driver.
Bring the Paper Size menu down and select the
desired page size. Click Ok. This step needs to be
done before you print from each file and the setting
can NOT be saved.
2. Go to File/Print. Select the Stylus Photo 2200
printer driver. Bring Copies and Pages menu down
and select Print Settings.
3. Leave the Media Type set to Plain Paper and
Print Quality to Normal - 360dpi.
(Note: High Speed is checked but is not available.)
4. Bring Print Settings menu down and select Color
Management. Choose Color Controls and Gamma
1.8.
5. Set the Mode to Vivid.
6. Saturation should be set to +25%. Magenta and
Yellow to +5%.
7. Bring Color Management menu down and select
Ink Configuration. Set the Color Density to +20%.
8. Save this setting as TJ-Cartoon-360. Bring
Presets menu down. Choose Save As. Name the
Preset to TJ-Cartoon-360.

Note: When you print again set your page size and then go to File/Print. Bring the
Presets menu down and select the new Preset of TJ-Cartoon-360.

Cartoon 720dpi (Mac OS X)
1. Go to File/Page Setup or Print Setup.
Under Format, select the Stylus Photo 2200
printer driver. Bring the Paper Size menu
down and select the desired page size.
Click Ok. This step needs to be done
before you print from each file and this
setting can NOT be saved.
2. Go to File/Print. Select the Stylus Photo
2200 printer driver. Bring Copies and
Pages menu down and select Print
Settings.
3. Leave the Media Type set to Enhanced
Matte Paper and Print Quality to Photo -
720dpi. Un-check High Speed.
4. Bring Print Settings menu down and
select Color Management. Choose Color Controls and Gamma 1.8.
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5. Set the Mode to Vivid.
6. Saturation should be set to +25%. Magenta and Yellow to +5%.
7. Bring Color Management menu down and select Ink Configuration. Set the Color
Density to +20%.
8. Save this setting as TJ-Cartoon-720. Bring Presets menu down. Choose Save
As. Name the Preset to TJ-Cartoon-720.
Note: When you go to print again set your page size and then go to File/Print. Bring
the Presets menu down and select the new Preset of TJ-Cartoon-720.

Cartoon 720dpi - High Speed (Mac OS X)
Follow the exact steps for Cartoon 720dpi but check High Speed.
Save this setting as TJ-Cartoon-720HS.

Photo 360dpi Mac OS X
For images that are photorealistic or have skin tones and reference colors, you
should create Print Modes that are more accurate with less color saturation. These
will be called the Photo modes.
1. Go to File/Page Setup or Print Setup.
Under Format for select the Stylus Photo 2200
printer driver. Bring the Paper Size menu
down and select the desired page size. Click
Ok. This step needs to be done before you
print from each file and this setting can NOT
be saved.
2. Go to File/Print. Select the Stylus Photo
2200 printer driver. Bring Copies and Pages
menu down and select Print Settings.
3. Leave the Media Type set to Plain Paper
and Print Quality to Normal - 360dpi.
4. Bring Print Settings menu down and select
Color Management. Choose Color Controls.
5. Set the Mode to Photo-realistic.
6. Bring Color Management menu down and select Ink Configuration. Set the Color
Density to +20%.
7. Save this setting as TJ-Photo-360. Bring Presets menu down. Choose Save
As. Name the Preset to TJ-Photo-360.
Note: When you go to print again set your page size. Then go to File/Print. Bring
the Presets menu down and select the new Preset of TJ-Photo-360.
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Photo 720dpi Mac OS X
1. Go to File/Page Setup or Print Setup. Under Format, select the Stylus Photo
2200 printer driver. Bring the Paper Size menu down and select the desired page
size. Click Ok. This step needs to be done before you print from each file and this
setting can NOT be saved.
2. Go to File/Print. Select the Stylus Photo 2200 printer driver. Bring Copies and
Pages menu down and select Print Settings.
3. Leave the Media Type set to Enhanced Matte Paper and Print Quality to Photo -
720dpi. Un-check High Speed.
4. Bring Print Settings menu down and select Color Management. Choose Color
Controls.
5. Set the Mode to Photo-realistic.
6. Bring Color Management menu down and select Ink Configuration. Set the Color
Density to +20%.
7. Save this setting as TJ-Photo-720. Bring Presets menu down. Choose Save
As. Name the Preset to TJ-Photo-720.
Note: When you go to print again set your page size. Then go to File/Print. Bring
the Presets menu down and select the new Preset of TJ-Photo-720.

Photo 720dpi - High Speed (Mac OSX)
Follow the exact steps for Photo 720dpi but check High Speed.
Save this setting as TJ-Photo-720HS.
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Requirements and Notices
Requirements for PC and Mac
Minimum Requirements for Windows

Macintosh Minimum System Requirements
(This is ONLY for the SDT 1000 Standard T-Jet with the seven color ink system and
no white capabilities.)

Microsoft Windows compatible PC with a Pentium II 266 MHz (Windows 98 or
Me) or 350 MHz (Windows 2000 or XP) or (Pentium III 500 MHz recommended).

A minimum of 512MB of RAM is recommended. 1 GB to 2 GB is preferred.

A minimum of 1 GB of free disk space on your hard disk.

A display monitor with high resolution.

CD-ROM or DVD drives for installing the software.

USB connection: a USB that complies with Windows (USB 2.0 port is
recommend).

Parallel connection: an IEEE-1284 with D-SUB, 21-pins, (computer end) and a
36-pin Printer.

IEEE 1394 (Firewire) Connection: an OHCI- compliant IEEE-1394 port and
interface card and an IEEE-1394 cable.

An Apple, or iMac series, Power Macintosh G3 or G4, PowerBook, or iBook.

Mac OS 8.6 through 9.2, OSX 10.2.8 through 10.4.X (Mac OS 9.2 or higher
is recommended).

512MB of RAM or higher recommended. 1 GB to 2 GB is preferred.

A minimum of 1 GB of free disk space on your hard disk.

Monitor with good resolution.

CD-ROM or DVD drives for installing the software.

USB connection: a USB that complies with Windows.

IEEE 1394 (Firewire) Connection: an OHCI- compliant IEEE-1394 port and
interface card and an IEEE-1394 cable.
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T-Jet2 SDT-1200 Specifications
Method of Printing: I n k-Jet
Print Resolutions: 2880 X 1440dpi

1440 X 720dpi
720 X 720dpi Recommended for photographic detailed
images.
360 X 360dpi Recommended for non-critical images.

Max. Printable Width: 12.5” (31.75cm) Without metal holding ring. 12” (30.5cm) 
with metal holding ring.

Max. Printable Length:19” (48.26cm) Without metal holding ring. 18.5” (47cm) 
with metal holding ring.

Interface Ports: Parallel Interface, USB, IEEE1394 AC110v+-10% with power
trans. pre-installed

Power: AC 110v–230v. 35watts (Approx. 1 amp.)
External Dimensions: Width: 28” (71cm) With bulk ink system. 

Length: 47” (119cm) 
Height: 17” (40cm)

Weight: 90 pounds (40KG) Unboxed
120 pounds (54KG) Boxed for shipping

Recommended Environment

For Operations & Storage: Temperature: 50F ~ 95F 10c~35c
Humidity: 35~80% (non condensation)

These specs are for the machine only.
For ink and pretreatment consult the container labels for proper storage and
disposal.
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FCC Compliance
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy,
and if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
WARNING: The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification of this device and may cause
interface levels which exceeds the limits established by the FCC for this equipment.
It is the responsibility of the user to obtain and use a shielded equipment interface
cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not
expressly approved by the manufacturer could void the authority to operate the
equipment.
For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.
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Declaration of Conformity
According to 47CFR, Part 15 for Class B Personal Computers and Peripherals; and
or CPU Boards and Power Supplies used with Class B Personal Computers:
We: U.S. Screen Print & Inkjet Technology a division of U.S. Graphic Arts, Inc.
Located at: 1901 East 5th Street Tempe, AZ 85043 Telephone: (480) 929-2937
Declare under sole responsibility that the product identified herein, complies with
47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product
marketed is identical to the representative unit tested and found to be compliant with
the standards. Records maintained continue to reflect the equipment being produced
can be expected to be within the variation accepted, due to quantity production and
testing on a statistical basis as required by 47CFR 2.909. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.
Trade Name:
U.S. Screen Print & Inkjet Technology Home of the U.S Screen Printing Institute

Type of Product: Ink Jet Printer

Model: T-Jet2 SDT-1000 and SDT-1200

European Union Declaration of Conformity - CE

A sample of this equipment has been tested against the Essential Health and
Safety Requirements of the Machinery Directive. Based on conformity with the
Machinery Directive, the Equipment Under Test - T-Jet2 from U.S. Graphic Arts,
Inc., dba U.S. Screen Print & Inkjet Technology in Tempe, Arizona USA is deemed
in compliance with the Machinery Directive (98/37/EC) and the Council Directives
amending the Machinery Directive (91/368/EEC) and 93/44/EEC). In addition, the
Equipment Under Test complies with the requirements of the Low Voltage
Directive (73/23/EEC) and the EMC Directive (89/336/EEC).

1




